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1. [bookmark: _Refd18e1045][bookmark: _Tocd18e1045][bookmark: _Refd18e898][bookmark: _Tocd18e898][bookmark: _Toc169270680] Getting Started
Welcome to your new Brailliant™ BI 20X Braille display. 
This user guide provides instructions for orientation, usage, navigation, and updating of the device. For more information, please refer to the Brailliant BI 20X product page on the HumanWare website or call your nearest HumanWare supplier.
You can always find the most recent version of this document in the User guide application that is present in the main menu of this device. 
Please note: to be sure that your device downloads the most recent version of this user guide when available, please make sure to connect it regularly to Internet.

1.1. [bookmark: _Toc169270681]In the Box
The box contains the following items:
· Brailliant™ X Series braille display
· USB-C to USB-A cable
· USB to AC adapter
· Nylon carrying case with lanyard
· Print Getting Started guides
· Braille insert on how to access user guide
1.2. [bookmark: _Toc169270682]Orientation of Brailliant BI 20X
[bookmark: _Refd18e916][bookmark: _Tocd18e916]The Brailliant BI 20X has a 20-cell braille display, a Perkins-style keyboard, two Space bars, a Home button and four thumb keys for navigation. 
1.2.1. [bookmark: _Toc169270683]Top Face
The top face of the Brailliant can be divided into two sections: front and rear.
The front section of the top face consists of a refreshable braille display containing 20 braille cells and 20 cursor routing buttons. Each cursor routing button is associated with the braille cell directly below it. When editing text, pressing one of the cursor routing buttons moves the editing cursor to the associated braille cell. While in the menus, pressing any cursor button activates the selected item. 
When you are not editing text, any cursor button activates a selected item. 
The rear section of the top face includes a Perkins-style braille keyboard where each key represents a Dot on a braille cell. The keys under your left hand represent Dots 1, 2, 3, and Backspace, where Dot 1 is located under your index finger and Backspace under your little finger. The keys under your right hand represent Dots 4, 5, 6, and Enter, where Dot 4 is located under your index finger and Enter under your little finger.
1.2.2. [bookmark: _Refd18e959][bookmark: _Tocd18e959][bookmark: _Toc169270684]Front Edge
On the front edge of the Brailliant are five buttons. From left to right, the buttons are as follows:
· Previous thumb key
· Left thumb key 
· Home button (circular shape) – used to return to the Main menu, exit Terminal mode or access to the settings when in Terminal mode only (see section 6.6 “Terminal mode only”
· Right thumb key
· Next thumb key
1.2.3. [bookmark: _Refd18e983][bookmark: _Tocd18e983][bookmark: _Toc169270685]Left Edge
On the left edge, from front to back are the following:
· USB-A port 
· Power button – press and hold this button for 2 seconds to turn the device ON. 
· Green LED – visually indicates the status of the device
· USB-C port – use the cable that came with your Brailliant to connect it to a power outlet or a PC.
1.2.4. [bookmark: _Toc169270686][bookmark: _Refd18e1016][bookmark: _Tocd18e1016]Right Edge
On the right edge, from front to back are the following:
· Two volume buttons 
· 3.5mm Audio jack 
1.2.5. [bookmark: _Toc169270687]Rear Edge
The rear edge only contains an SD card port located near the left edge of the device. This port allows you to insert SD cards for external storage.
1.2.6. [bookmark: _Refd18e1026][bookmark: _Tocd18e1026][bookmark: _Toc169270688]Bottom Side
In each corner underneath your Brailliant are four anti-slip pads. 
In the middle, closer to the front edge is a slightly indented rectangle with a different texture. In this rectangle is a sticker containing printed hardware information about your Brailliant. Above the sticker, there is a braille label containing the serial number of your device.
Towards the back left of the device is the battery compartment. It is closed and secured with two Phillips-head screws. 
1.3. [bookmark: _Refd18e1101][bookmark: _Tocd18e1101][bookmark: _Toc169270689]Charging Brailliant BI 20X
Prior to using your Brailliant, make sure it is charged completely. 
Connect the USB-C end of the recharge cable to the USB-C port located on the left edge of your Brailliant. Minimal effort is required and forcing the connection can damage the cable or the device. 
Connect the USB-A end of the recharge cable to the power adapter, then plug the power adapter into a power outlet. Use the provided power adapter for optimal recharge.
[bookmark: _Numd18e1123][bookmark: _Refd18e1123][bookmark: _Tocd18e1123]Alternatively, you can charge the device using your computer and the USB-A to USB-C recharge cable, but note that this method of charging is slower than charging with a power adapter.
1.4. [bookmark: _Toc169270690]Powering On and Off
The Power button is on the left edge of the Brailliant. It is oval-shaped with a raised dot in the center. 
If your device is charged, press and hold the Power button for approximately 2 seconds to power on the Brailliant. There is a quick vibration and “starting” appears on the braille display along with a tactile loading animation that circles during start-up. 
A few moments after you boot your device for the first time, you will be welcomed with a language selection menu. Press Enter to open the list of languages, select one and press Enter to close the list. The options of the menu will be spoken via a text-to-speech feature using the default primary selected voice.
Another item available is “Start in terminal”. If you prefer the Brailliant to startup in terminal mode each time from a complete shutdown, you can activate this by pressing Enter. Refer to the user settings section for more information on activating or deactivating the start up in terminal.
Close the dialog box once the changes are completed.
After a few seconds, the start-up is complete and “terminal” appears on the braille display. Your Brailliant is now ready for use. 
If however you turned on start in terminal, the Brailliant will prompt “USB connection”. 
To power Off, press and hold the Power button for approximately 2 seconds. A confirmation message appears on the braille display. Select Ok by pressing the Previous or Next thumb key, then press Enter or a Cursor-routing key.
Alternatively, you can follow these steps to power Off the Brailliant:
· Press P to reach the Power Off menu item.
· Press Enter or a cursor routing key.
· Select Ok by pressing the Previous or Next thumb key.
· Press Enter or a cursor routing key.
1.5. [bookmark: _Refd18e1174][bookmark: _Tocd18e1174][bookmark: _Toc169270691]Adjusting the Sleep Mode and auto power off
1.5.1. [bookmark: _Toc845884171][bookmark: _Toc169270692]Adjusting the Sleep mode 
To preserve the battery, Brailliant goes into Sleep mode after 5 minutes of inactivity. You can adjust the length of time in the Settings. You can also manually put your device into Sleep mode by a short press of the power button. 
If the device is in the sleep status, to wake up the device, short press the Power button.
1.5.2. [bookmark: _Toc1299257091][bookmark: _Toc169270693]Adjusting the auto power off
Auto power off will automatically power off your device after a designated period of inactivity.  By default, your device will shutdown automatically after 3 hours of inactivity to preserve the battery life of your Brailliant. You can modify this setting in the user settings, under the “Auto power off subsection”. Here, you will have the opportunity to set the auto power off after 1 hour, 2 hours, 3 hours (by default), 4 hours or never if you don’t want your device to auto power off. 
When the auto power off time is reached, a message asking if you want to shutdown will be displayed. If you don’t react during the next minute, the device will automatically shut down.If your device has been shutdown automatically, press and hold the Power button during 2 seconds to restart your device. 

1.6. [bookmark: _Toc169270694]About the About Menu
The About menu provides various information about your device, such as version numbers, model number, serial number, licenses, and copyright.
To open the About Menu:
· Go to the Main menu.
· Select Options.
· Press Enter. 
· Go to the About item.
· Press Enter. 
Alternatively, you can use the shortcut Space + I to open the About dialog. 
1.7. [bookmark: _Toc38273993][bookmark: _Toc416443718][bookmark: _Toc169270695]Launching the Main Menu
The KeySoft Main menu is your Brailliant’s default home menu. From the main menu, you can access all KeySoft Lite applications. When you start your Brailliant or close an application, you automatically return to this menu.
You can at any time return to the main menu by simply pressing the Home button on your Brailliant (the button shaped like a circle located on the front edge of your Brailliant, in the middle). Alternatively, you can use the Go to Main Menu command on the keyboard by pressing SPACE with DOTS 1 2 3 4 5 6. 
2. [bookmark: _Toc169270696] Navigating and Using Menus
KeySoft Lite is the heart of your Brailliant BI 20X, supporting all applications that are built in your braille display. KeySoft’s main menu can also be customized, which will allow you to hide and unhide applications from the Main menu. More information on customizing your Main Menu can be found in the Customize KeySoft’s Main Menu section.
2.1. [bookmark: _Toc169270697]Navigating the Main Menu
The Main menu contains the following items:
· Terminal
· Editor: KeyPad
· Braille editor : KeyBrf
· Victor Reader
· File manager : keyFiles
· Calculator : keyCalc
· Date and time
· Options
· Online services
· User guide
· Power Off
Press the Previous or Next thumb keys to scroll through the list to the menu item of your choice. Then press Enter or a cursor routing key to access it.
[bookmark: _Refd18e1251][bookmark: _Tocd18e1251]You can return to the Main menu at any time by pressing the Home button or Space with all six Dots.
2.2. [bookmark: _Toc169270698]Panning Text on the Braille Display
Often times the text on the braille display is too long to fit on a single line. To read the entire sentence, scroll or “pan” the text ahead or back by pressing the Left and Right thumb keys on the Brailliant. The Left and Right thumb keys are the second and third buttons on the front edge of the device. 
2.3. [bookmark: _Refd18e1266][bookmark: _Tocd18e1266][bookmark: _Toc169270699]Using the Context Menu for Additional Functions
The Contextual Menu lists all available actions for the KeySoft application you are currently working in as well as their associated commands. It can be very useful when you forget how to do a specific command. 
To activate the Context Menu, press Space + M. A menu opens with a list of actions you can perform at that particular moment. Scroll through the menu to the desired action and press Enter or a cursor routing key. 
Press Space + E to exit the Context Menu.
2.4. [bookmark: _Toc169270700]Navigating by First Letters of Words
Most of the time, you can jump to an item in a menu by typing the first letter of that item. Doing so automatically moves your focus to the first item in the list starting with that letter. Typing the same letter twice moves the focus to the second item in the list starting with that letter, and so on. 
For example, to reach the Options menu on the Brailliant, you type the letter ‘O’ on your keyboard.
Note that KeySoft apps found on your main menu are optimized for first letter navigation.
It is also possible to easily switch between applications without the need to return to the main menu. Providing you know the first letter of the application you want to open, press the letter combined with Enter and Backspace. 
For example, to open the Editor: KeyPad application, type the letter ‘E’ with Enter + Backspace. 
2.5. [bookmark: _Refd18e1309][bookmark: _Tocd18e1309][bookmark: _Toc169270701]Using Shortcuts/Key Combinations to Navigate
As the name implies, shortcuts, also known as key combinations, make it easy to quickly navigate through a menu or file. 
The most commonly used shortcuts on the Brailliant BI 20X are indicated in Table 1.
Table 1: Shortcut/Key Combination Table
	Action
	Shortcut or Key Combination

	Activate Selected item
	Enter or cursor routing key

	Escape or Back
	Space + E

	Previous item
	Previous thumb key or Space + Dot 1

	Next item
	Next thumb key or Space + Dot 4

	Jump to any item in a list
	Type the first letter of the item or app

	Pan left and right
	Left or Right thumb key

	Go to top
	Space + Dots 1-2-3

	Go to bottom
	Space + Dots 4-5-6

	Toggle Braille grade
	Backspace + G

	Switch language profile
	Enter + L

	Battery level
	Enter + P

	Context menu
	Space + M

	Main menu
	Space + Dots 1-2-3-4-5-6 or Home button

	System information
	Space + I

	Time
	Enter + T

	Date
	Enter + D

	Eject media
	Enter + E

	Options
	Space + O

	Create a quick note
	Backspace + N

	Create a quick braille note
	Backspace + B

	Toggle speech on/off
	Space + Previous Thumb Key

	Increase speech rate
	Enter + Dot 5

	Decrease speech rate
	Enter + Dot 2

	Open Terminal
	Backspace + Enter + T

	Open KeyPad
	Backspace + Enter + E

	Open Victor Reader
	Backspace + Enter + V

	Open KeyFiles 
	Backspace + Enter + F

	Open KeyCalc
	Backspace + Enter + C

	Open Bookshare
	Backspace + Enter + B

	Open NFB Newsline
	Backspace + Enter + W

	Open NLS Bard
	Backspace + Enter + N

	Search for WIFI
	Backspace + Enter + S

	Help
	Space + H



Note: All commands that include Enter or Backspace must have the Space Bar added to them when using computer braille.
3. [bookmark: _Refd18e1364][bookmark: _Tocd18e1364][bookmark: _Toc169270702] Using the KeyPad Application
KeyPad is an application that allows you to open, edit, and create text files on the Brailliant. You can open .docx, .doc, .odt, .txt, .brf, .brl, pdf, .ban, and .bra files with KeyPad. The files you create or modify are saved as a .txt file.
To open KeyPad, press the Next thumb key until you reach Editor:KeyPad or press ‘e’ in the Main menu, then press Enter or a cursor routing key.
KeyPad opens a sub menu, which includes Create file, Open file, Recently Saved, Editor settings, and Close.
3.1. [bookmark: _Refd18e1411][bookmark: _Tocd18e1411][bookmark: _Toc169270703]Create a File
There are several ways to create a file depending on your current location on the device. 
· If you are in the KeyPad menu, select Create file and press Enter or a cursor routing key.
· From the Context menu, select and activate File menu, then Create file. 
· Alternatively, press Backspace + N from anywhere on the device to quickly create a new file.
The cursor is visible between two braille brackets, and can be set as blinking in the User settings. You can begin writing in your new file. 
3.2. [bookmark: _Refd18e1434][bookmark: _Tocd18e1434][bookmark: _Toc169270704]Open a File
If you are in the KeyPad menu, select Open file and press Enter or a cursor routing key. Alternatively, you can press Backspace + O, then select the file you wish to open using the Previous and Next thumb keys.
Note that the Brailliant can display an error message when a PDF file is opened. This generally occurs when the file contains images rather than text.
3.3. [bookmark: _Toc101600279][bookmark: _Toc169270705]Recently Saved
You can open a list of the last ten documents you previously saved for quick access.
To open a list of the ten most recent files, select the KeyPad application from the main menu. Use your Previous or Next thumb keys until you reach recently saved and press Enter.
You can scroll through the ten most recent files using the Previous and Next thumb keys. Press Enter or a cursor-routing key to open a file from the list.
3.4. [bookmark: _Refd18e1452][bookmark: _Tocd18e1452][bookmark: _Toc169270706]Close a File
To close a file that is opened in KeyPad, press Space + E. Alternatively, open the Context menu using Space + M, then scroll to and activate the File menu. Select Close file item.
If there are changes to your file that have not been saved, you are asked if you want to save the changes before closing.
Note: If your device shuts down before you have saved your document, when you will restart your device and return to Keypad, a message will be prompted indicating that the file was not closed properly and asking you if you want to open or to discard the file.
3.5. [bookmark: _Refd18e1472][bookmark: _Tocd18e1472][bookmark: _Toc169270707]Save a Text File
There are two types of saving in KeyPad: Save and Save as.
Save: Press Space + S to save your file to an already existing filename.
Save as: Press Backspace + S to save a copy of your file with a new filename and change the location.
If your file has never been saved, KeyPad asks you to enter a new filename regardless of the save method you choose.
Note that if you open a file under any extension other that .txt, the device will prompt a message asking if you wish to keep the original file in addition to the .txt file that will be saved. 
3.6. [bookmark: _Toc169270708]Auto Scrolling Through Written Text in the KeyPad
The KeyPad app features an Auto Scroll functionality that automatically pans through the written text on the braille display. 
To start Auto Scrolling, press Enter + Dots 1-2-4-5-6. 
To stop Auto Scrolling, press any key.
3.6.1. [bookmark: _Refd18e1514][bookmark: _Tocd18e1514][bookmark: _Toc169270709]Modifying Auto Scroll Speed
You can change the Auto Scroll speed when auto-scrolling inside a file. 
To slow down Auto Scroll, press Enter + Dot 3.
To speed up Auto Scroll, press Enter + Dot 6.
3.7. [bookmark: _Refd18e1529][bookmark: _Tocd18e1529][bookmark: _Toc169270710]Finding Text in a File
To find text in your file, press Space + F. Enter your search term in the blank field. Your cursor is placed at the first location the text is found. 
Press Space + N to find additional instances of the search word. 
Press Space + P to reach previous instances of the search word.
3.7.1. [bookmark: _Refd18e1541][bookmark: _Tocd18e1541][bookmark: _Toc169270711]Finding and Replacing Text
To find and replace text: 
· Press Backspace + F. 
· [bookmark: _Hlk37858074]Enter the text to find in the first edit box.
· Enter the text to replace it within the second prompted edit box.
· Press the Next button to find the next instance of the word. 
· Press the Next button to find Replace All. 
3.8. [bookmark: _Refd18e1554][bookmark: _Tocd18e1554][bookmark: _Toc169270712]Cutting, Copying, and Pasting Text
KeyPad lets you cut, copy, and paste text in a way similar to computer programs. 
To select the text, position your cursor on the first character using a cursor routing button, then press Enter + S. 
Alternatively, you can select text from the Context menu:
· Open the Context menu with Space + M. 
· Scroll down to Edit.
· Press Enter or a cursor routing key. 
· Scroll down to Select Text. 
· Press Enter or a cursor routing key.
This marks the start of your selection. Now go to the location at the end of your selection, and press Enter + S to end the selection.
To select All text included in the file, press Enter + Dots 1-2-3-4-5-6.
To copy the selected text, press Backspace + Y.
To cut the selected text, press Backspace + X.
To paste the copied or cut text, position your cursor where you want the text to be pasted using a cursor routing button and press Backspace + V.
As always, these commands can be accessed through the Context menu.
The Backspace + Y shortcut can also be used to copy the last result from the KeyCalc application and the current paragraph in the Victor Reader application. 
3.9. [bookmark: _Refd18e1601][bookmark: _Tocd18e1601][bookmark: _Toc169270713]Using the Read Mode
Read mode allows you to read files without the possibility of editing content by mistake. You cannot edit files while in Read mode. 
To activate or deactivate Read mode, press Space + X.
To activate or deactivate Read mode from the Context menu:
· Press Space + M to activate the Context menu.
· Scroll to File using the Previous and Next thumb keys.
· Press Enter or a cursor routing key. 
· Scroll to Read mode using the Previous and Next thumb keys.
· Press Enter or a cursor routing key.
3.10. [bookmark: _Toc169270714]Inserting Date and Time
When creating a file in the KeyPad application, you have the option to insert the current date and time in the file. 
To insert date and time:
· Press Space + M to activate the Context menu.
· Scroll to Edit using the Previous and Next thumb keys.
· Press Enter or a cursor routing key. 
· Scroll to Insert using the Previous and Next thumb keys.
· Press Enter or a cursor routing key. 
· Scroll to Insert date or Insert time using the Previous and Next thumb keys.
· Press Enter or a cursor routing key.
3.11. [bookmark: _Toc76540403][bookmark: _Toc169270715]Adding, Navigating, and Removing Bookmarks
Bookmarks are a useful way to keep your location within a file and allow you to return quickly to that position at a later time. 
To open the Bookmark menu, press Enter + M. You can also press Space + M to open the Context menu and select Bookmark menu.
3.11.1. [bookmark: _Toc76540404][bookmark: _Toc169270716]Inserting a Bookmark
To add a bookmark in a file:
· Press Enter + M to open the Bookmark menu. 
· Select Insert Bookmark using the Previous and Next thumb keys.
· Press Enter or a cursor routing key. 
· Enter a specific unused bookmark number. 
· Note: If you do not enter a number, Brailliant selects the first available number and assigns it to the bookmark.
· Press Enter. 
· Alternatively, you can insert a Bookmark by pressing Enter + B. Note that a maximum of 98 bookmarks can be inserted in a KeyPad document.
3.11.2. [bookmark: _Toc76540405][bookmark: _Toc169270717]Navigating to Bookmarks
To jump to a bookmark, press Enter + J. You are prompted to enter the bookmark number. Enter the bookmark number you wish to navigate to, then press Enter.
3.11.3. [bookmark: _Toc76540406][bookmark: _Toc169270718]Removing Bookmarks
To remove a saved Bookmark:
· Press Enter + M to open the Bookmark menu. 
· Scroll to Remove Bookmark using the Previous and Next thumb keys.
· Press Enter or a cursor routing key. 
· Enter the Bookmark number you want to remove.
· Press Enter.
Note: If you want to remove all bookmarks in the document type 99 when prompted Bookmark number.
3.12. [bookmark: _Toc101600293][bookmark: _Toc169270719]Toggle Text Indicators
Text indicators are a useful tool to help you locate your position when working in document of the Editor. Upon activating the text indicators, brackets will appear on the braille display to indicate the beginning and the ending of the text.
To toggle text indicators:
· Press Space + M to activate the Context menu.
· Use the Previous or Next thumb keys until you reach File Menu and press Enter.
· Use the Previous or Next thumb keys until you read editor settings and press Enter.
· Use the Previous or Next thumb keys until you reach show text editor indicators.
· Press Enter to deactivate the Text indicators; press Enter again to activate them.
Note that toggling Text Indicators will only apply to the editor; all other edit fields will continue to include text indicators.
3.13. [bookmark: _Refd18e1625][bookmark: _Tocd18e1625][bookmark: _Toc169270720]KeyPad Commands Table
The KeyPad commands are listed in Table 2.
Table 2: KeyPad Commands
	Action
	Shortcut or Key Combination

	Activate edit mode
	Enter or a cursor routing key

	Leave edit mode
	Space + E

	Create file
	Backspace + N

	Open file
	Backspace + O

	Save
	Space + S

	Save as
	Backspace + S

	Find 
	Space + F

	Find next
	Space + N

	Find previous
	Space + P

	Replace
	Backspace + F

	Start/Stop selection
	Enter + S

	Select all 
	Enter + Dots 1-2-3-4-5-6

	Copy
	Backspace + Y

	Cut
	Backspace + X

	Paste
	Backspace + V

	Delete previous word
	Backspace + Dot 2

	Delete current word
	Backspace + Dots 2-5

	Delete previous character
	Backspace 

	Move to next edit box while editing
	Enter 

	Move to next edit box without editing
	Next thumb key

	Move to previous edit box without editing
	Previous thumb key

	Move insertion point to start of text field document
	Space + Dots 1-2-3 

	Move insertion point to end of text field document
	Space + Dots 4-5-6 

	Start auto-scroll
	Enter + Dots 1-2-4-5-6

	Increase auto-scroll speed
	Enter + Dot 6

	Decrease auto-scroll speed
	Enter + Dot 3

	Read all (text-to-speech feature)
	Space + G

	Stop reading (text-to-speech feature)
	Backspace + Enter

	Toggle Reading mode 
	Space + X

	Bookmark menu
	Enter + M

	Jump to bookmark
	Enter + J

	Insert Bookmark
	Enter + B


4. [bookmark: _Toc101600295][bookmark: _Toc169270721] Using the KeyBrf Application 
KeyBrf is an application similar to KeyPad, but explicitly designed to edit, open and create braille documents in .brf and .brl format. The files are created, modified, and saved as .brf.
To open KeyBrf, press the Next thumb key until you reach the item Braille Editor: KeyBrf or press “B” in the Main menu, then press Enter or a cursor-routing key.
KeyBrf opens with the Braille Editor menu, which includes Create File, Open File, Recently Saved, Braille Editor Settings, and Close.
Note that the Text-to-speech (TTS) feature is not possible with the Braille Editor application.
4.1. [bookmark: _Toc101600296][bookmark: _Toc169270722]Create a File
There are several ways to create a file, depending on your current location on the device. 
· If you are in the Braille Editor menu, select Create File and press Enter or a cursor-routing key.
· From the Context menu, select and activate the File menu, then select Create File. 
· Alternatively, press Backspace + B from anywhere on the device to quickly create a new .brf file.
The cursor will be visible between two braille brackets, and can be set as blinking in the User settings. You can begin writing in your new file. 
4.2. [bookmark: _Toc169270723]Open a file
If you are in the Braille Editor menu, select Open File and press Enter or a cursor-routing key. Alternatively, you can press Backspace + O, then select the file you wish to open using the Previous and Next thumb keys.  
4.3. [bookmark: _Toc101600298][bookmark: _Toc169270724]Recently Saved
You can open a list of the last ten documents you previously saved for quick access.
To open a list of the ten most recent files, select the KeyBrf application from the main menu. Use your Previous or Next thumb keys until you reach recently saved and press Enter.
You can scroll through the ten most recent files using the Previous and Next thumb keys. Press Enter or a cursor-routing key to open a book from the list.
4.4. [bookmark: _Toc101600299][bookmark: _Toc169270725]Close a File
To close a file that is opened in the Braille Editor, press Space + E. Alternatively, open the Context menu using Space + M, then scroll to and activate the File menu. Select Close File Item.
If there are changes to your file that have not been saved, you will be asked if you want to save the changes before closing.
Note: If your device shuts down before you have saved your document, when you will restart your device and return to KeyBRF, a message will be prompted indicating that the file was not closed properly and asking you if you want to open or to discard the file. 

4.5. [bookmark: _Toc101600300][bookmark: _Toc169270726]Save a Braille File
There are two types of saving in KeyBrf: Save and Save as.
Save: Press Space + S to save your file to an already existing file name.
Save as: Press Backspace + S to save a copy of your file with a new file name and to change the file location.
If your file has never been saved, KeyBrf will ask you to enter a new file name regardless of the save method you choose.
4.6. [bookmark: _Toc101600301][bookmark: _Toc169270727]Export a Braille File to Text
The .brf files opened in the Braille Editor application can be exported as text files. This can be useful if you wish to open them in the Editor application and work on them in another format.
To export a braille file to text:
· Press Space + M to open the Context menu. 
· Use the Previous and Next thumb keys to select the option Export as text and press Enter.
· The Brailliant will display a list of braille tables for exportation. Use the Previous and Next thumb keys to select the braille table of your choice and press Enter. 
· You will be prompted to enter a name for the exported file. Type the desired name and press Enter.
· You will be prompted with the list of KeyFiles folders in which you can save your newly created file. Select the folder of your choice using the Previous and Next thumb keys and press Enter.
4.7. [bookmark: _Toc101600302][bookmark: _Toc169270728]Using Auto-Scroll in KeyBrf
The KeyBrf app includes an Auto-Scroll feature that automatically pans through the written text on the braille display. 
To start Auto-Scroll, press Enter + Dots 1-2-4-5-6. 
To stop Auto-Scroll, press any key.
4.7.1. [bookmark: _Toc101600303][bookmark: _Toc169270729]Modifying Auto-Scroll Speed
You can change the Auto-Scroll speed when auto-scrolling inside a file. 
To slow down Auto-Scroll, press Enter + Dot 3.
To speed up Auto-Scroll, press Enter + Dot 6.
4.8. [bookmark: _Toc101600304][bookmark: _Toc169270730]Finding Text in a File
To find text in your file, press Space + F. Enter your search term in the blank field. Your cursor will be placed at the first location the text is found. 
Press Space + N to find additional instances of the search word. 
Press Space + P to reach previous instances of the search word.
a. [bookmark: _Toc100576119][bookmark: _Toc100594909][bookmark: _Toc101515174][bookmark: _Toc101600305][bookmark: _Toc101602403][bookmark: _Toc101602554][bookmark: _Toc101602703][bookmark: _Toc101604801][bookmark: _Toc102656525][bookmark: _Toc107243383][bookmark: _Toc109056740][bookmark: _Toc109116449][bookmark: _Toc109120600][bookmark: _Toc109120752][bookmark: _Toc109632206][bookmark: _Toc109638518][bookmark: _Toc109639276][bookmark: _Toc144895030][bookmark: _Toc144970164][bookmark: _Toc144992880][bookmark: _Toc144993032][bookmark: _Toc146108619][bookmark: _Toc146116140][bookmark: _Toc146119633][bookmark: _Toc146119919][bookmark: _Toc146120077][bookmark: _Toc146179986][bookmark: _Toc146180307][bookmark: _Toc146181283][bookmark: _Toc146181440][bookmark: _Toc146181659][bookmark: _Toc146183854][bookmark: _Toc146185344][bookmark: _Toc146269190][bookmark: _Toc146803974][bookmark: _Toc146812142][bookmark: _Toc146812628][bookmark: _Toc160116944][bookmark: _Toc169253879][bookmark: _Toc169270731]
4.8.1. [bookmark: _Toc101600306][bookmark: _Toc169270732]Finding and Replacing Text
To find and replace text: 
· Press Backspace + F. 
· Enter the text to find in the first edit box, called Find.
· Enter the replacement text in the second edit box, called Replace.
· Select Replace All to replace all text found with the text in the Replace box. 
· Select Next to find and replace the next instance of the word.
· Select Previous to find and replace the previous instance of the word.
4.9. [bookmark: _Toc101600307][bookmark: _Toc169270733]Cutting, Copying, and Pasting Text
KeyBrf lets you cut, copy, and paste text in a way similar to computer programs. 
To select the text, position your cursor on the first character using a cursor-routing key, then press Enter + S. 
Alternatively, you can select text from the Context menu:
· Open the Context menu with Space + M. 
· Scroll down to Edit.
· Press Enter or a cursor-routing key. 
· Scroll down to Select Text. 
· Press Enter or a cursor-routing key.
This marks the start of your selection. Now go to the location at the end of your selection, and press Space + S to end the selection.
To select all text included in the file, press Enter + Dots 1-2-3-4-5-6.
To copy the selected text, press Backspace + Y.
To cut the selected text, press Backspace + X.
To paste the copied or cut text, position your cursor where you want the text to be pasted using a cursor-routing key and press Backspace + V.
As always, these commands can be accessed through the Context menu.
The Backspace + Y shortcut can also be used to copy the last result from the KeyCalc application and the current paragraph in the Victor Reader application. 
4.10. [bookmark: _Toc101600308][bookmark: _Toc169270734]Using Read Mode
Read mode allows you to read files without the possibility of editing content by mistake. You cannot edit files while in Read mode. 
To activate or deactivate Read mode, press Space + X.
To activate or deactivate Read mode from the Context menu:
· Press Space + M to activate the Context menu.
· Scroll to File using the Previous and Next thumb keys.
· Press Enter or a cursor-routing key.
· Scroll to Read mode using the Previous and Next thumb keys.
· Press Enter or a cursor-routing key.
4.11. [bookmark: _Toc101600309][bookmark: _Toc169270735]Adding, Navigating, and Removing Bookmarks
Bookmarks are a useful way to keep your location within a file and allow you to return quickly to that position at a later time. 
To open the Bookmark menu, press Enter + M. You can also press Space + M to open the Context menu and select Bookmark menu.
b. [bookmark: _Toc100594914][bookmark: _Toc101515179][bookmark: _Toc101600310][bookmark: _Toc101602408][bookmark: _Toc101602559][bookmark: _Toc101602708][bookmark: _Toc101604806][bookmark: _Toc102656530][bookmark: _Toc107243388][bookmark: _Toc109056745][bookmark: _Toc109116454][bookmark: _Toc109120605][bookmark: _Toc109120757][bookmark: _Toc109632211][bookmark: _Toc109638523][bookmark: _Toc109639281][bookmark: _Toc144895035][bookmark: _Toc144970169][bookmark: _Toc144992885][bookmark: _Toc144993037][bookmark: _Toc146108624][bookmark: _Toc146116145][bookmark: _Toc146119638][bookmark: _Toc146119924][bookmark: _Toc146120082][bookmark: _Toc146179991][bookmark: _Toc146180312][bookmark: _Toc146181288][bookmark: _Toc146181445][bookmark: _Toc146181664][bookmark: _Toc146183859][bookmark: _Toc146185349][bookmark: _Toc146269195][bookmark: _Toc146803979][bookmark: _Toc146812147][bookmark: _Toc146812633][bookmark: _Toc160116949][bookmark: _Toc169253884][bookmark: _Toc169270736]
c. [bookmark: _Toc100594915][bookmark: _Toc101515180][bookmark: _Toc101600311][bookmark: _Toc101602409][bookmark: _Toc101602560][bookmark: _Toc101602709][bookmark: _Toc101604807][bookmark: _Toc102656531][bookmark: _Toc107243389][bookmark: _Toc109056746][bookmark: _Toc109116455][bookmark: _Toc109120606][bookmark: _Toc109120758][bookmark: _Toc109632212][bookmark: _Toc109638524][bookmark: _Toc109639282][bookmark: _Toc144895036][bookmark: _Toc144970170][bookmark: _Toc144992886][bookmark: _Toc144993038][bookmark: _Toc146108625][bookmark: _Toc146116146][bookmark: _Toc146119639][bookmark: _Toc146119925][bookmark: _Toc146120083][bookmark: _Toc146179992][bookmark: _Toc146180313][bookmark: _Toc146181289][bookmark: _Toc146181446][bookmark: _Toc146181665][bookmark: _Toc146183860][bookmark: _Toc146185350][bookmark: _Toc146269196][bookmark: _Toc146803980][bookmark: _Toc146812148][bookmark: _Toc146812634][bookmark: _Toc160116950][bookmark: _Toc169253885][bookmark: _Toc169270737]
d. [bookmark: _Toc100594916][bookmark: _Toc101515181][bookmark: _Toc101600312][bookmark: _Toc101602410][bookmark: _Toc101602561][bookmark: _Toc101602710][bookmark: _Toc101604808][bookmark: _Toc102656532][bookmark: _Toc107243390][bookmark: _Toc109056747][bookmark: _Toc109116456][bookmark: _Toc109120607][bookmark: _Toc109120759][bookmark: _Toc109632213][bookmark: _Toc109638525][bookmark: _Toc109639283][bookmark: _Toc144895037][bookmark: _Toc144970171][bookmark: _Toc144992887][bookmark: _Toc144993039][bookmark: _Toc146108626][bookmark: _Toc146116147][bookmark: _Toc146119640][bookmark: _Toc146119926][bookmark: _Toc146120084][bookmark: _Toc146179993][bookmark: _Toc146180314][bookmark: _Toc146181290][bookmark: _Toc146181447][bookmark: _Toc146181666][bookmark: _Toc146183861][bookmark: _Toc146185351][bookmark: _Toc146269197][bookmark: _Toc146803981][bookmark: _Toc146812149][bookmark: _Toc146812635][bookmark: _Toc160116951][bookmark: _Toc169253886][bookmark: _Toc169270738]
4.11.1. [bookmark: _Toc101600313][bookmark: _Toc169270739]Inserting a Bookmark
To add a bookmark in a file:
· Press Enter + M to open the Bookmark menu. 
· Select Insert Bookmark using the Previous and Next thumb keys.
· Press Enter or a cursor routing key. 
· Enter a specific unused bookmark number. 
· Note: If you do not enter a number, the Brailliant selects the first available number and assigns it to the bookmark.
· Press Enter. 
Alternatively, you can insert a Bookmark by pressing Enter + B. Note that a maximum of 98 bookmarks can be inserted in a document.
4.11.2. [bookmark: _Toc101600314][bookmark: _Toc169270740]Navigating to Bookmarks
To jump to a bookmark, press Enter + J. You are prompted to enter the bookmark number. Enter the bookmark number you wish to navigate to, then press Enter.
4.11.3. [bookmark: _Toc101600315][bookmark: _Toc169270741]Removing Bookmarks
To remove a saved Bookmark:
· Press Enter + M to open the Bookmark menu. 
· Scroll to Remove Bookmark using the Previous and Next thumb keys.
· Press Enter or a cursor routing key. 
· Enter the Bookmark number you want to remove.
· Press Enter.
Note: If you want to remove all bookmarks in the document type 99 when prompted Bookmark number.
4.12. [bookmark: _Toc101600316][bookmark: _Toc169270742]Toggle Text Indicators
Text indicators are a useful tool to help you locate your position when working in document of the Braille Editor. Upon activating the text indicators, brackets will appear on the braille display to indicate the beginning and the ending of the text.
To toggle text indicators:
· Press Space + M to activate the Context menu.
· Use the Previous or Next thumb keys until you reach file menu and press Enter.
· Use the Previous or Next thumb keys until you reach editor settings and press Enter. 
· Use the Previous or Next thumb keys until you reach show text editor indicator. 
· Press Enter to deactivate the Text indicators; press Enter again to activate them.
Note that the toggling Text Indicators will only apply to the Braille editor, all other edit fields will continue to include text indicators. 
4.13. [bookmark: _Toc169270743]Format BRF
KeyBRF offers Braille formatting options. It can be very useful to format your Braille documents the way they will be printed in Braille. 
To adjust the Braille formatting of your documents, go to the KeyBRF application. Then, in the menu, press Enter on the Editor settings. In this window, you will find the option “Format BRF”. Press Enter to activate this option, press Enter again to deactivate it. If you continue to navigate in that window, you will be able to select the number of characters per line to display, and the number of lines per page. These two controls can be modified to display exactly the number of characters per line and the number of lines per page that you want in your Braille document when you will print it. To modify one of these controls, press Enter on the desired one, then change the default value indicated, then press Enter to confirm your choice.
When on a BRF document, if the “Format BRF” option is activated, two options are added to the Contextual menu, in the File menu. You can be informed of your exact position in your document depending of the Braille formatting options chosen; this is the Where Am I function. To obtain this information, you can also press the shortcut Space + Dots 1-5-6. You can also access to a preview of your document when printed in braille. To access to the preview mode, you can also use the shortcut Enter + V.
Note: even though you deactivate the option “Format markers” in the Keysoft’s User settings menu, they will be rendered when your document will be in Preview mode.
[bookmark: _Toc169270744]4.13.1. Preview mode
When the “Format BRF” option is enabled, you will have the opportunity to read your document in preview mode, by using the shortcut Enter + V or by selecting this option in the context menu. In this mode, your document will be displayed as formatted as the way it will be presented when printed in Braille, according to the format BRF settings configured.
Please note that even though the format markers were disabled in the Keysoft’s settings, they will be displayed to help you apprehend more precisely the content of your future printed Braille document. Here are more explanations about the format markers.
To tell you how a document is formatted, KeySoft places special format markers at particular points in a document. These format markers are displayed on the Braille display. You may have encountered a number of special groups of symbols on the Braille display when you were reviewing your document. They tell you how the document is formatted. When displaying format markers, KeySoft follows the guidelines set for literary Braille format established by the Braille Authority of North America.
On the Braille display, if the cursor is positioned under a format marker, it appears under each of the characters of the format marker.
Format markers are groups of symbols that always start with a computer Braille dollar sign, $. In US computer Braille this is dots 1‑2‑4‑6 which is the same as the grade 2 "ed" contraction. In UK computer Braille it is dots 4‑5‑6. There is always a space before the $ and another space after the group of symbols. The symbol or symbols following the $ determine what the format marker is showing.
Here are the format markers that you will go through in your document.
New Line: $p.
Form feed: $f
Tab: $t 
4.14. [bookmark: _Toc101600317][bookmark: _Toc169270745]KeyBrf Commands Table
The Braille Editor commands are listed in Table 3.
Table 3: KeyBrf Commands
	Action
	Shortcut or Key Combination

	Activate Edit mode
	Enter or a cursor-routing key

	Leave Edit mode
	Space + E

	Create braille file
	Backspace + B

	Open braille file
	Backspace + O

	Save
	Space + S

	Save as
	Backspace + S

	Find 
	Space + F

	Find next
	Space + N

	Find previous
	Space + P

	Replace
	Backspace + F

	Start/stop selection
	Enter + S

	Select all 
	Enter + Dots 1-2-3-4-5-6

	Copy
	Backspace + Y

	Cut
	Backspace + X

	Paste
	Backspace + V

	Delete previous word
	Backspace + Dot 2

	Delete current word
	Backspace + Dots 2-5

	Delete previous character
	Backspace 

	Move to next edit box while editing
	Enter 

	Move to next edit box without editing
	Next thumb key

	Move to previous edit box without editing
	Previous thumb key

	Move insertion point to start of text field document
	Space + Dots 1-2-3 

	Move insertion point to end of text field document
	Space + Dots 4-5-6 

	Start auto-scroll
	Space + Dots 1-2-4-5-6

	Increase Auto-Scroll speed
	Enter + Dot 6

	Decrease auto-scroll speed
	Enter + Dot 3

	Toggle Reading mode 
	Space + X

	Where Am I? (Format BRF option  On)
	Space + Dots 1-5-6

	Preview mode (Format BRF option  On)
	Enter + V

	Bookmark menu
	Enter + M

	Jump to bookmark
	Enter + J

	Insert Bookmark
	Enter + B



5. [bookmark: _Refd18e1672][bookmark: _Tocd18e1672][bookmark: _Toc169270746] Using Victor Reader
Victor Reader is the application you use to read or listen to books on the Brailliant. It supports the following file formats:
· .brf
· .pef
· .txt
· .html
· .docx
· .odt
· DAISY 2
· DAISY 2.02
· Niso
· .rtf
· .ban
· .bra
· Pdf
· .FB2
To open the Victor Reader app, press the Next thumb key until you reach Victor Reader, or press ‘V’ in the Main menu. Press Enter or a cursor routing key to access the app.
The Victor Reader menu includes Book list, Recently read, Search, and Close.
5.1. [bookmark: _Toc169270747]Navigating the Book List
In Victor Reader, your books are stored in a Book List, comparable to a directory containing all the available media on your device in alphabetical order.
Use the Previous and Next thumb keys to select a book from your Book List, then press Enter or a cursor routing key.
Note that the Brailliant can display an error message if a PDF file book is opened. This generally occurs when the file contains images rather than text.
To close a book and return to the Book List, press Space + E or Space + B.
5.1.1. [bookmark: _Refd18e1750][bookmark: _Tocd18e1750][bookmark: _Toc169270748]Searching for Books
To search for a specific book on the device: 
· [bookmark: _Hlk37858943]Select Search from the Victor Reader menu or press Space + F. 
· Type in the text/name of book.
· Press Enter. 
· You are presented with a list of books matching your search criteria. 
· Use the Previous and Next thumb keys to scroll to the book.
· Press Enter or a cursor routing key to open it.
5.1.2. [bookmark: _Toc169270749]Accessing Recently Opened Books
You can open a list of the last five books you previously opened for quick access.
To open a list of the five most recent books, press Enter + R or select Recently read from the Victor Reader menu. 
You can scroll through the five most recent books using the Previous and Next thumb keys. Press Enter or a cursor routing key to open a book from the list.
5.1.3. [bookmark: _Toc169270750][bookmark: _Numd18e1803][bookmark: _Refd18e1803][bookmark: _Tocd18e1803]Managing Your Books
When browsing the Book List, you can copy, move, or delete a selected book from the Victor Reader application to an external storage device. The actions that are available for each book depend on the type and location of the book. The Context menu tells you what actions are available.
The basic rules are:
· [bookmark: _Hlk37860446]Books located on the SD card can be deleted.
· Books downloaded from online services can be moved or deleted.
· Books can only be copied or moved to/from when external storage is connected. 
· You are unable to copy or move books from within the internal storage. 
To copy, move, or delete a book:
· Access the book list by pressing Space + B. 
· Select a book using the Previous or Next thumb keys.
· Press Backspace + M to open the Manage Book menu. 
· Select Copy to, Move to, or Delete. 
5.2. [bookmark: _Toc169270751]Navigating and Accessing Additional Information in Books
The easiest way to navigate inside a book is by using the thumb keys. Use the Left and Right thumb keys to pan the text left and right. 
5.2.1. [bookmark: _Refd18e1812][bookmark: _Tocd18e1812][bookmark: _Toc169270752]Changing the Navigation Level for Books
[bookmark: _Hlk37860605]The Victor Reader includes different navigation levels to make navigating through a book easier. Navigation levels are dependent on each book and may differ from book to book. 
To change the Navigation level:
· [bookmark: _Hlk37860740]Press Space + T.
· Scroll through the available Navigation levels using the Previous and Next thumb keys.
· Press Enter or a cursor routing key to select the Navigation level.
Once the Navigation level is selected, use the Previous and Next thumb keys to navigate at this Navigation level. 
For example, if you selected the "Sentence" Navigation level, pressing the Next thumb key would move you from sentence to sentence within the book.
Alternatively, you can select the Navigation level of your choice using a quick shortcut:
· Press Backspace + Dot 6 to access the next Navigation level OR Press Backspace + Dot 3 to access the previous Navigation level.
· Press the Previous or Next thumb key to navigate within the book in the Navigation level selected. 
5.2.2. [bookmark: _Toc169270753]Navigating by Page, Heading, Percentage, or Bookmarks in a Book
To reach a specific page, heading, book percentage, or bookmark:
· Press Enter + G. 
· Scroll through the navigation options using the Previous and Next thumb keys.
· Choose between Page, Heading, Percent, or Bookmark.
· Note that the options available will vary based on the formatting available of the book.
· Press enter or a cursor routing key. 
· Enter a value.
· Press Enter.
5.2.3. [bookmark: _Refd18e1869][bookmark: _Tocd18e1869][bookmark: _Toc169270754]Auto-Scrolling Through Text in Books in the Victor Reader App
[bookmark: _Hlk37861688]The Auto-scroll feature of the Brailliant BI 20X allows you to scroll through the text of an open book automatically. 
To turn On Auto-scroll, press Enter + Dots 1-2-4-5-6 when inside a book. Press any key to stop the Auto-scroll and return to the regular Panning mode.
You can modify the Auto-scroll speed when auto-scrolling inside a book. 
[bookmark: _Numd18e1900][bookmark: _Refd18e1900][bookmark: _Tocd18e1900]To slow down Auto-scroll, press Enter + Dot 3. 
To speed up Auto-scroll, press Enter + Dot 6.
5.2.4. [bookmark: _Toc169270755]Finding Your Current Position in a Book
Use the Where am I command whenever you need to know your current position within a book. 
To activate the Where am I command, press Space + Dots 1-5-6.
Alternatively, access the Context menu by pressing Space + M. Go to Where am I using the Previous and Next thumb keys, then press Enter or a cursor routing key to activate the item.
Use the Previous and Next thumb keys to scroll through the available elements (Heading, Percent, Page, and Line). Use the Left and Right thumb keys to pan the text left and right.
5.2.5. [bookmark: _Refd18e1925][bookmark: _Tocd18e1925][bookmark: _Toc169270756]Navigating to the Beginning or End of a Book
You can reach the beginning or end of a book using shortcuts. 
To reach the beginning of a book, press Space + Dots 1-2-3. 
To reach the end of a book, press Space + Dots 4-5-6.
5.2.6. [bookmark: _Refd18e1940][bookmark: _Tocd18e1940][bookmark: _Toc169270757]Searching for Text in a Text Book
Another way to navigate within a book is to search for a specific string of text. 
To search for text, press the Space + F command. You are prompted to enter the text. Type the text, then press Enter.
5.2.7. [bookmark: _Refd18e1955][bookmark: _Tocd18e1955][bookmark: _Toc169270758]Accessing Additional Book Information
You can display additional information about the book you are currently reading on the device (title, author, description, date, language, subject, publisher, and bookmarks).
To display additional book information, press Space + I. 
You can also press Space + M to open the Context menu. Use the Previous and Next thumb keys to select the Book Information menu item, then press Enter or a cursor routing key to activate it.
Use the Previous and Next thumb keys to scroll through the available book information. Use the Left and Right thumb keys to pan the text left and right.
5.3. [bookmark: _Refd18e1986][bookmark: _Tocd18e1986][bookmark: _Toc169270759]Adding, Navigating, Highlighting, and Removing Bookmarks
Bookmarks are a useful way to keep your location within the book and allow you to return quickly to that position at a later time, whether a physical position in a text book or a time position in an audiobook.
[bookmark: _Numd18e1995][bookmark: _Refd18e1995][bookmark: _Tocd18e1995]To open the Bookmark menu, press Enter + M. You can also press Space + M to open the Context menu and select Bookmark menu.
5.3.1. [bookmark: _Toc169270760]Inserting a Bookmark
To add a bookmark in a book:
· Press Enter + M to open the Bookmark menu. 
· Select Insert Bookmark using the Previous and Next thumb keys.
· Press Enter or a cursor routing key. 
· Enter a specific unused bookmark number. 
· Note: If you do not enter a number, Brailliant selects the first available number and assigns it to the bookmark.
· Press Enter. 
Alternatively, you can insert a Quick Bookmark by pressing Enter + B.
5.3.2. [bookmark: _Refd18e2026][bookmark: _Tocd18e2026][bookmark: _Toc169270761]Navigating to Bookmarks
To jump to a bookmark, press Enter + J. You are prompted to enter the bookmark number. Enter the bookmark number you wish to navigate to, then press Enter.
5.3.3. [bookmark: _Refd18e2041][bookmark: _Tocd18e2041][bookmark: _Toc169270762]Highlighting Bookmarks 
[bookmark: _Hlk37863095]The Highlight Bookmarks menu item is used to define the Start and the End positions of a passage. Using highlighted bookmarks is a great way to study important passages in textbooks.
To highlight bookmarks:
· Open the Bookmark menu by pressing Enter + M.
· Select Highlight Bookmark Start using the Previous and Next thumb keys.
· Press Enter or a cursor routing key. 
· Enter a specific unused bookmark number.
· Note: If you do not enter a number, your Brailliant selects the first available number and assigns it to the bookmark.
· Press Enter. 
· Navigate to the end point of the highlighted passage. 
· Open the Bookmark menu by pressing Enter + M. 
· Select Highlight Bookmark End using the Previous and Next thumb keys.
· Press Enter or a cursor routing key. 
The current position is set as the ending position. If the end position is placed before the start position, they are switched. 
You can also insert a Quick Bookmark. It is used to mark the end of the Highlight Bookmark.
To insert a Quick Bookmark:
· Press Enter + H to open the Highlight Bookmark list. 
· Select a Highlight Bookmark number.
· Press Enter. 
· The content of the current Highlight Bookmark is displayed. 
· Use the thumb keys to navigate. 
· Press Space + E to close the Highlight Bookmark and return to the entire book content.
5.3.4. [bookmark: _Refd18e2067][bookmark: _Tocd18e2067][bookmark: _Toc169270763]Removing Bookmarks
To remove a saved Bookmark:
· Press Enter + M to open the Bookmark menu. 
· Scroll to Remove Bookmark using the Previous and Next thumb keys.
· Press Enter or a cursor routing key. 
· Enter the Bookmark number you want to remove.
· Press Enter.
[bookmark: _Refd18e2091][bookmark: _Tocd18e2091]Note: If you want to remove all bookmarks type 99999 when prompted Bookmark number.
5.4. [bookmark: _Toc169270764]Victor Reader and Reading Commands Tables
The Victor Reader and reading commands for text books are listed in Table 4.
Table 4: Victor Reader/Reading Commands for text books
	Action
	Shortcut or Key Combination

	Book list 
	Space + B

	Manage books
	Backspace + M

	Go to Option menu
	Enter + G

	Bookmark menu
	Enter + M

	Jump to bookmark
	Enter + J

	Insert Quick Bookmark
	Enter + B

	Show Highlight Bookmarks
	Enter + H

	Open Navigation level
	Space + T

	Previous element
	Previous thumb key

	Next element
	Next thumb key

	Change to previous Navigation level
	Backspace + Dot 3

	Change to next Navigation level
	Backspace + Dot 6

	Start Auto-scroll
	Enter + Dots 1-2-4-5-6

	Increase Auto-scroll speed
	Enter + Dot 6

	Decrease Auto-scroll speed
	Enter + Dot 3

	Read all (text-to-speech feature)
	Space + G

	Stop reading (text-to-speech feature)
	Backspace + Enter

	Where am I
	Space + Dots 1-5-6

	Info
	Space + I

	Go to beginning of book
	Space + Dots 1-2-3

	Go to end of book
	Space + Dots 4-5-6

	Open recent books 
	Enter + R

	Search for books or text
	Space + F

	Find next
	Space + N

	Find previous
	Space + P

	Next non-blank line
	Enter + Dot 4

	Previous non-blank line
	Enter + Dot 1

	Previous character
	Space + Dot 3

	Next character
	Space + Dot 6 

	Previous word
	Space + Dot 2

	Next word
	Space + Dot 5

	Previous paragraph
	Space + Dots 2-3

	Next paragraph
	Space + Dots 5-6

	Start/Stop selection
	Enter + S

	Select all (current paragraph)
	Enter + Dots 1-2-3-4-5-6

	Copy (current paragraph)
	Backspace + Y

	Delete book
	Backspace + Dots 2-3-5-6



Victor Reader and reading commands for audiobooks are listed in Table 5.
Table 5: Victor Reader Commands for audiobooks
	Action
	Shortcut or Key Combination

	Book list 
	Space + B

	Manage books
	Backspace + M

	Go to Option menu
	Enter + G

	Bookmark menu
	Enter + M

	Jump to bookmark
	Enter + J

	Insert Quick Bookmark
	Enter + B

	Show Highlight Bookmarks
	Enter + H

	Open Navigation Level
	Space + T

	Previous element
	Previous thumb key

	Next element
	Next thumb key

	Change to previous Navigation level
	Backspace + Dot 3

	Change to next Navigation level
	Backspace + Dot 6

	Where Am I
	Space + Dots 1-5-6

	Info
	Space + I

	Go to beginning of book
	Space + Dots 1-2-3

	Go to end of book
	Space + Dots 4-5-6

	Open recent books 
	Enter + R

	Delete book
	Backspace + Dots 2-3-5-6

	Play audiobook
	Space + G

	Stop the reading
	Backspace + Enter

	Fast forward 5 seconds
	Right thumb key (single press)

	Rewind 5 seconds 
	Left thumb Key (single press)

	Fast forward (Longer time jumps)
	Right thumb key (press and hold)

	Rewind (Longer time jumps)
	Left thumb key (press and hold)

	Increase reading speed
	Enter + Dot 5

	Decrease reading speed
	Enter + Dot 2


6. [bookmark: _Refd18e2191][bookmark: _Tocd18e2191][bookmark: _Toc169270765] Using Terminal Mode
One of the main features of the Brailliant is Terminal mode. When connected to a host device running a screen reader, such as a computer or a smart device, Terminal mode displays all text selected on the host device. 
You can connect to your host device either through Bluetooth® wireless technology, or by connecting the USB-C cable included with your Brailliant to the host device. Up to five Bluetooth devices and one USB can be connected at one time.
[bookmark: _Hlk144888720][bookmark: _Refd18e2226][bookmark: _Tocd18e2226][bookmark: _Hlk144906194]Note that if a device is connected to the Brailliant via USB, you can have the Brailliant  automatically start the connection. See “Ask to open USB connection” in the User Settings Options Table for available settings options.
6.1. [bookmark: _Toc169270766]Connecting and Exiting Terminal Mode
To connect in Terminal mode, make sure you have a Windows®, iOS®, Android, or Mac® device with a screen reader running.
To activate Terminal mode:
· Press Space + Dots 1-2-3-4-5-6 or the Home button to enter the Main menu.
· Go to Terminal by pressing ‘t’ or by using the Previous and Next thumb keys.
· Press Enter or a cursor routing key.
To exit Terminal mode and access the list of connected devices, press the Home button once.
6.1.1. [bookmark: _Toc169270767]Determining Brailliant BI 20X Compatibility
The Brailliant is compatible with the following:
Screen readers: JAWS® 18+ (version 18 and newer), NVDA, SuperNova, Chromevox (USB only), Android (USB only) and VoiceOver 
Operating systems: Windows 8+, Android, macOS® 10.15+ (Catalina), or iOS device 13.4+ 
6.1.2. [bookmark: _Toc169270768]Waking Your iOS Device Using the Brailliant 
With your iOS device locked, pressing any cursor routing keys on the Brailliant wakes it up to enter your passcode. This allows you to keep your iOS device in a pocket or bag while you use the Brailliant as its controller and output.
6.1.3. [bookmark: _Toc169270769][bookmark: _Toc146181696]Connecting by USB
(Note that steps in this section assume that the “always connect” option is not enabled)
To connect via USB:
· Connect the Brailliant to a Windows or Mac computer with the USB-C cable. 
· Select Connected devices (first item in the Terminal menu).
· Press Enter. 
· Select USB connection.
· Press Enter.
· Wait for the connection to be established. 
If the connection is successful, the content of your host device is shown on the braille display. 
The Brailliant is now also available as an external keyboard to type on the host device.
6.1.4. [bookmark: _Toc169270770]Connecting by Bluetooth
To pair a new device in Bluetooth:
· From the host device, activate Bluetooth.
· On the Brailliant, go to the Main menu.
· Select Terminal and press Enter or a cursor routing key. 
· In the Terminal menu, select Add Bluetooth device and Press Enter.
· If Bluetooth is Off, it is automatically activated. Note that once the Bluetooth mode is activated, your display is now in a 5-minute discoverable mode.
· Note that at any time, you can press and hold the Enter key for 5 seconds to set the device in a 5-minute discoverable mode.
· The braille display will prompt instructions on how to connect to the host device. From the host device, initiate the Bluetooth pairing with the Brailliant BI 20X.
· On the braille display, a message will prompt: “xx is connected”, where xx is the name of the host device. 
· The focus is directed to the list of connected devices. 
· Use the Previous and Next thumb keys to move through the list of connected devices until you reach the host device you are trying to connect with. Press Enter or a cursor routing key to activate it.
If the connection is successful, the content of your host device is shown on the braille display.
Note: If using Windows 11 with Bluetooth connectivity, you may need to access your PC's Bluetooth settings and select "Advanced" under "Bluetooth devices discovery." Failure to do so may result in Humanware braille displays not appearing in the list of pairable devices.
6.2. [bookmark: _Toc76540433][bookmark: _Toc169270771]Terminal Clipboard
When a selection of text is copied or cut, it is stored in a global clipboard and can be pasted on other locations on the device. This feature can be useful if you wish, for example, to copy a passage from a book in Victor Reader and paste it in a document in KeyPad. 
The global clipboard can also be used when using external devices paired with the Brailliant via USB or Bluetooth. Currently, JAWS for Windows and VoiceOver are supporting the terminal clipboard. All other screen readers might have difficulty in handling the clipboard.  When using the Terminal clipboard, please note there is a 360 character limitation.
To copy an item to a connected device:
· Press Backspace + Y to copy the element of your choice.
· On the connected device, access the location where you wish to paste the item.
· Enter the bypass command Space + Enter + Dots 4-5-6. The message “Enter local command” will be displayed. The bypass command allows you to use some internal functions on the Brailliant while being connected to an external device, such as the Battery Status, and showing the Date and Time. 
· Press Backspace + V to paste the item on the connected device.
6.3. [bookmark: _Toc814111235][bookmark: _Toc169270772][bookmark: _Toc146725644][bookmark: _Numd18e2335][bookmark: _Refd18e2335][bookmark: _Tocd18e2335]Navigating Between Connected Devices
When you have more than one device connected with the Brailliant, you can switch devices at any time. 
To switch to another connected device, press the Home button + Next thumb key or Home button + Previous Thumb key.
Alternatively, you can navigate to another connected device by doing the following: 
· Press the Home button to return to the list of connected devices.
· Select the connected device using the Previous and Next thumb keys.
· Press Enter or a cursor routing key.
Note: When a Bluetooth device is connected, an 8-dot symbol is displayed after the device name. If the 8-dot symbol is not visible, click on the device to establish the connection. 
If you have problems with a Bluetooth connection, you can click on Reconnect devices. This turns Bluetooth Off and back On and reconnects your devices. Use this option if you are not getting any braille when connected to a device.
6.4. [bookmark: _Toc169270773]USB connections in Terminal mode
[bookmark: _Hlk144971303](Note that steps in this section assume that the “always connect” option is not enabled)
When using the Brailliant in terminal mode, it is possible to either be prompted to connect with a USB connection or automatically start the connection upon inserting a USB cable from a host device.
To activate the “Ask to open USB connection” feature in terminal mode:
· Go to the Main menu.
· Select Options and press Enter. 
· Select User Settings and press Enter.
· Use the Previous and Next thumb keys until you reach the item “Ask to open USB connection”, then press Enter.
· Here, 3 options are available: “Never ask”, “Ask for connection” and “Always connect”. Use the Previous and Next thumb keys until you reach the item you require, then Press Enter.
6.5. [bookmark: _Toc146108660][bookmark: _Toc146116181][bookmark: _Toc146108661][bookmark: _Toc146116182][bookmark: _Toc146108662][bookmark: _Toc146116183][bookmark: _Toc146108663][bookmark: _Toc146116184][bookmark: _Toc146108664][bookmark: _Toc146116185][bookmark: _Toc146108665][bookmark: _Toc146116186][bookmark: _Toc146108666][bookmark: _Toc146116187][bookmark: _Toc101600346][bookmark: _Toc169270774]Disable Perkins Keyboard in Terminal Mode
When using the Brailliant in terminal mode, it is possible to disable the Perkins-style keyboard to simplify your use of the device. 
To disable the keyboard in terminal mode:
· Go to the Main menu.
· Select Options and press Enter. 
· Select User Settings and press Enter.
· Use the Previous and Next thumb keys until you reach the item Disable Perkins in terminal.
· Press Enter to disable the Perkins keyboard in terminal mode; press Enter again to enable it.
Note that the Brailliant thumb keys and command keys will still be working when the Perkins keyboard is disabled.
6.6. [bookmark: _Toc88611943][bookmark: _Toc169270775]Terminal only mode
Consider enabling 'Terminal only mode' on your braille display if you find that the standalone KeySoft suite applications are underutilized or too complex. This mode removes internal applications, transforming the display into a terminal only. It streamlines connections to screen readers on your computer via USB or on your mobile device via Bluetooth. To activate or de-activate the Terminal Only mode, you will have to access the diagnostic menu (see section 17 “Accessing the diagnostic menu”). 
In Terminal only mode, when booting the device, you are prompted ‘braille display’. If your device is plugged into a computer, it will work with your screen reader instantly.
Please note: this mode comes with the following limitations. 
· Text-to-speech is not available. You will only have access to braille.
· All menus will be displayed in grade 1 and will not be configurable. 
· Sleep mode is not present in Terminal only mode. It remains possible to manually put the device in Sleep mode by doing a short press on the Power button.  
· Only one Bluetooth device can be connected and paired in this mode. When activating the Terminal only mode, if more than one Bluetooth device had been previously configured on your device, All the devices except one will be forgotten and you will have to pair them again if you want to use them in the future. 
· If a device is connected on Bluetooth and another on USB at the same time, the device connected on USB connection will always have the priority. 
· Accessing and exiting  the options menu is different when Terminal Only mode is enabled. A limited set of options will be available, (see section 6.6.1 about the options in Terminal Only mode). 
· The Bypass local command is not working in this mode. For example, you will not be able to copy/paste some text from the terminal clipboard as described in section 6.2.
6.6.1. [bookmark: _6.6.2_Using_the][bookmark: _Toc1992832154][bookmark: _Toc169270776]Using the Options in Terminal Only mode
To use the options in Terminal only mode, press and hold the Home button until you feel a short vibration. To exit the Options, press and hold again the Home button.
Here are the options available in Terminal only mode:
· User settings: airplane mode, message display time, auto power off, vibration, beep, wireless notifications, one-handed mode, disable perkins in terminal.
· Wifi
· Bluetooth
· Change language
· Activate exam mode
· Software update
· About
7. [bookmark: _Refd18e2347][bookmark: _Tocd18e2347][bookmark: _Toc169270777] Using KeyFiles
KeyFiles allows you to browse, delete, copy, and perform all the file operations you would expect from a PC file manager.
To open KeyFiles, press the Next thumb key until you reach File Manager : KeyFiles. 
Alternatively, you can open KeyFiles by pressing F in the Main menu, then press Enter or a cursor routing key.
7.1. [bookmark: _Refd18e2364][bookmark: _Tocd18e2364][bookmark: _Toc169270778]Browsing Files
You can browse through your files and folders using the Previous and Next thumb keys. Folder names have an 8-dot symbol in front of the folder name. Press Enter on a folder to open it.
Press Space + E to return to the parent folder. Alternatively, you can scroll to the Back item, then press Enter or a cursor routing key.
7.1.1. [bookmark: _Refd18e2389][bookmark: _Tocd18e2389][bookmark: _Toc169270779]Selecting a Drive in KeyFile
Before using KeyFiles, you first need to choose which drive you wish to access: the internal memory, an SD card, or a USB flash drive. 
To select a drive, press Space + D to display a list of available drives. Scroll through the list using the Previous or Next thumb keys, then press Enter or a cursor routing key to confirm your choice. 
You are now at the root of your selected drive.
Press Space + D at any time to return to the Drive Selection screen.
7.1.2. [bookmark: _Refd18e2419][bookmark: _Tocd18e2419][bookmark: _Toc169270780]Accessing File, Folder, or Drive Information
To get additional information on a file or folder, select it using the Previous or Next thumb keys, then press Space + I.
You can now scroll through a list of information on the file or folder using the Previous and Next thumb keys. Use the Left and Right thumb keys to pan the text left and right.
The Space + I shortcut can also be used to expose the amount of internal memory of a drive.
7.1.3. [bookmark: _Refd18e2445][bookmark: _Tocd18e2445][bookmark: _Toc169270781]Displaying the Current File Path
The Where Am I function allows you to display the path of your current location on the braille display of the Brailliant.
To display your current file path, press Space + Dots 1-5-6.
7.1.4. [bookmark: _Refd18e2462][bookmark: _Tocd18e2462][bookmark: _Toc169270782]Searching for Files and Folders
You can promptly access a certain file or folder by performing a search in KeyFiles.
To start searching for a file or folder in KeyFiles:
· Press Space + F.
· Type in the file or folder name.
· Press Enter.
· A list of files and folders related to your search results is generated on the braille display.
· Press Space + E to close the search result.
7.1.5. [bookmark: _Refd18e2486][bookmark: _Tocd18e2486][bookmark: _Toc169270783]Sorting Files or Folders
By default, file and folder names are sorted alphabetically. However, you can sort the files and folders using different parameters.
To change the sorting parameters of your files and folders:
· Press Space + V.
· Brailliant displays a list of sorting options available: Name, Date, Size, and Type. 
· Scroll through the list using the Previous or Next thumb key.
· Press Enter or a cursor routing key to activate the sorting option of your choice. 
Selecting the same sorting parameter already selected, changes the information from ascending to descending and back again when selected once more.
7.2. [bookmark: _Refd18e2518][bookmark: _Tocd18e2518][bookmark: _Toc169270784]Modifying Files and Folders
KeyFiles on the Brailliant lets you work with files similarly to a computer or tablet. 
7.2.1. [bookmark: _Refd18e2530][bookmark: _Tocd18e2530][bookmark: _Toc169270785]Creating a New Folder
KeyFiles gives you the possibility to create new folders. 
The simplest way to do this is by pressing Space + N and entering the name of the new folder in the blank field. Then, press Enter to create it.
7.2.2. [bookmark: _Refd18e2547][bookmark: _Tocd18e2547][bookmark: _Toc169270786]Renaming Files or Folders
To rename a file or folder:
· Select the file or folder you wish to rename using the Previous and Next thumb keys. 
· Press Backspace + R.
· Enter the new file or folder name.
· Press Enter to rename the file or folder.
Note: The file name must be unique in your current directory, and only one file or folder can be renamed at a time. 
7.2.3. [bookmark: _Refd18e2572][bookmark: _Tocd18e2572][bookmark: _Toc169270787]Selecting Files or Folders for Applying Additional Actions
Before you can perform an action on a file or folder, such as cut, copy, or paste, you must first select (or Mark) the desired file or folder. 
To Mark a file or folder, select the file using the Previous or Next thumb keys, then press Backspace + L.
To Unmark a file or folder, select it and press Backspace + L again.
To Mark All files and folders in the current directory, press Enter + Dots 1-2-3-4-5-6.
7.2.4. [bookmark: _Refd18e2652][bookmark: _Tocd18e2652][bookmark: _Toc169270788][bookmark: _Refd18e2602][bookmark: _Tocd18e2602]Copying, Cutting, and Pasting Files or Folders
Copying and Cutting Files and Folders
To copy a single file or folder, select the file using the Previous or Next thumb keys, then press Backspace + Y.
To cut a single file or folder, select the file using the Previous or Next thumb keys, then press Backspace + X.
To copy or cut multiple files or folders: 
· Select the file or folder to copy using the Previous or Next thumb keys. 
· Press Backspace + L to Mark the file or folder.
· Repeat this step to Mark all files or folders to be copied.
· Press Backspace + Y to copy OR Backspace + X to cut.
· The files or folders are now copied/cut to the clipboard and ready to be pasted.
Pasting Files and Folders
To paste the copied or cut files or folders, navigate to the location where you want to paste to, then press Backspace + V.
7.2.5. [bookmark: _Toc169270789]Deleting Files or Folders
To delete a single file or folder, select the file using the Previous or Next thumb keys, then press Backspace + Dots 2-3-5-6.
To delete multiple files or folders:
· Select the file or folder you wish to delete using the Previous or Next thumb keys. 
· Once selected, press Backspace + L to Mark the file or folder.
· Repeat this step to Mark all files or folders you wish to delete.
· When ready to delete the Marked files or folders, press Backspace + Dots 2-3-5-6. 
Note: Brailliant asks if you are sure you want to delete the files and/or folders only when Confirm Deletion has been set to On in the Options menu. Select Yes using the Previous or Next thumb keys, and press Enter or a cursor routing key to confirm the deletion. For more information on the Confirm Deletion setting, go to the Setting User Preferences section.
7.3. [bookmark: _Refd18e2734][bookmark: _Tocd18e2734][bookmark: _Toc169270790]KeyFiles Commands Table
The KeyFiles commands are listed in Table 6.
Table 6: KeyFiles Commands
	Action
	Shortcut or Key Combination

	Create new folder 
	Space + N

	File/drive info 
	Space + I

	Mark/Unmark
	Backspace + L

	Mark all/Unmark all 
	Enter + Dots 1-2-3-4-5-6

	Rename file
	Backspace + R

	Delete file
	Backspace + Dots 2-3-5-6

	Copy file 
	Backspace + Y

	Cut file
	Backspace + X

	Paste file
	Backspace + V

	Search file 
	Space + F

	Sort files 
	Space + V

	Where am I 
	Space + Dots 1-5-6

	Select drive 
	Space + D

	Go to parent folder
	Space + E

	Eject media
	Enter + E


8. [bookmark: _Refd18e2800][bookmark: _Tocd18e2800][bookmark: _Toc169270791]Using the KeyCalc Application
The Brailliant features a calculator app that enables you to perform the most common operations. 
Note: KeyCalc currently supports Computer Braille only. 
To open KeyCalc:
· Go to the Main menu.
· Press C OR press the Previous or Next thumb keys until you reach the Calculator: KeyCalc menu item. 
· Press Enter or a cursor routing key.
8.1. [bookmark: _Toc169270792]Operating the Calculator
To use KeyCalc, write your complete equation, then press Enter to get the result. 
For example, type the equation 20-(6+8) (with no spaces). Press Enter and Brailliant displays 6 as the answer.
To clear the previous equation, press Space + Dots 3-5-6.
To add operators such as + or -, open the Context menu using Space + M. Refer to the KeyCalc Commands Table section, for a full list of KeyCalc commands and operators.
8.2. [bookmark: _Calculator_Commands_Table][bookmark: _Refd18e2847][bookmark: _Tocd18e2847][bookmark: _Toc169270793]KeyCalc Commands Table
The KeyCalc commands are listed in Table 7.
Table 7: Calculator Commands using US Computer Braille
	Action
	Shortcut or Key Combination

	Plus 
	Dots 3-4-6

	Minus
	Dots 3-6

	Multiply
	Dots 1-6

	Divide
	Dots 3-4

	Equals
	Enter

	Clear 
	Space + Dots 3-5-6

	Decimal point
	Dots 4-6

	Percent
	Dots 1-4-6

	Square root 
	Space + Dots 3-4-5

	Pi
	Space + Y



9. [bookmark: _Refd18e2894][bookmark: _Tocd18e2894][bookmark: _Toc169270794] Using the Date and Time Application
The Brailliant features an application that gives you the current date and time. 
To open Date and Time:
· Go to the Main menu.
· Press the Previous or Next thumb keys until you reach the Date and Time menu item.
· Press Enter or a cursor routing key.
9.1. [bookmark: _Refd18e2923][bookmark: _Tocd18e2923][bookmark: _Toc169270795]Displaying the Time and Date
When you open the Date and Time application, Brailliant displays the current time. 
Pan right once using the Right thumb key to display the date. 
Pan left using the Left thumb key to return to the time. 
To quickly review the date and time, press Enter + T for the time and Enter + D for date from anywhere on the Brailliant.
9.2. [bookmark: _Refd18e2938][bookmark: _Tocd18e2938][bookmark: _Toc169270796]Setting the Time and Date
To change the time and date, press Space + M from the Date and Time application.
A submenu opens with the following options: 
· Change time: Type the current hour inside the square brackets, press Enter; repeat for the minutes.
· Change date: Type the current year inside the square brackets and press Enter; repeat for the month and day.
· Daylight saving time: Press Enter to turn daylight saving time On or Off.
· Time format: Press Enter to change between 24h and 12h time format.
· Date format: Select the preferred date format (listed below) and press Enter. 
· Language default
· Day, Month, Year 
· Month, Day 
· Month, Day, Year 
· Year, Month, Day 
· Day, Month 
10. [bookmark: _Setting_User_Preferences][bookmark: _Options_Menu][bookmark: _Refd18e2965][bookmark: _Tocd18e2965][bookmark: _Toc169270797] Options Menu
The Options menu allows you to modify the settings of your Brailliant, and contains the following items:
· User settings
· Language Profile
· Wifi
· Bluetooth
· Main menu applications 
· Change language
· Activate exam mode
· Software update
· About
To open the Options menu, press the Next thumb key until you reach Options OR press ‘O’ in the Main menu, then press Enter or a cursor routing key. Alternatively, you can access the Options Menu by pressing Space + O.
11. [bookmark: _Toc169270798]User Settings
11.1. [bookmark: _Refd18e2980][bookmark: _Tocd18e2980][bookmark: _Toc169270799]User Setting Options Table
Table 8: Options Operations
	Setting
	Option/Result

	Airplane mode
	On or Off; when On, all wireless functionalities are disabled

	Format Markers
	On or Off; when Off, format markers are hidden

	Cursor visible
	On or Off

	Cursor blink
	On or Off; when On, the cursor will blink at a rate of 0.5 seconds.

	Message display time
	1–30 seconds: time of message displayed 

	Sleep time
	Number in minutes, from 0 to 60; 0 to turn Off

	Auto Power off
	The device shuts down automatically after a determined period of time, from 1 to 4 hours; never  turn off 

	Word wrap
	On or Off

	Condense blank lines
	On or Off; when On, blank lines are not visible

	Confirm deletion
	On or Off; when On, Brailliant asks for confirmation of file deletion

	Vibration
	On or Off; when On, Brailliant vibrates

	Beep
	On or Off; when On, Brailliant beeps

	Thumb keys configuration
	Map the Previous Item, Next Item, Pan Left, and Pan Right commands to the thumb key of your choice.

	Wireless notifications
	Enable or disable wireless and Bluetooth connection feedback

	One-handed mode
	On or Off; when On, dots keys can be pressed and released one-by-one, the dot combination is only confirmed once the Space key is pressed

	Start in terminal
	On or Off; when On, the device will automatically start in the Terminal menu upon restarting

	Disable Perkins in terminal
	On or off; when On, the Perkins-style keyboard will be disabled when the device is used in terminal mode

	Ask to open USB connection
	When connecting the device to a PC with a USB cable, there are three possible outcomes depending on the selection of Ask to open USB connection in the user settings.

1. If “never ask” is selected, nothing happens. 

2. If “ask for connection” is selected, the user will be asked if they want to open the connection.
 
3. If “always connect” is selected, the device will automatically connect to the PC.



11.2. [bookmark: _Adding,_Configuring,_and][bookmark: _Toc169270800]Adding, Configuring, and Deleting Language Profiles
[bookmark: _Hlk37926202]The Language Profile menu lists all the available Language Profiles on your Brailliant. The active Language Profile is underlined with dots 7 and 8 on the device. Creating multiple language profiles can allow you to easily switch quickly between braille tables and voices.
Scroll through the available Language Profiles using the Next and Previous thumb keys, then press Enter or a cursor routing key to select it.
11.2.1. [bookmark: _Refd18e3042][bookmark: _Tocd18e3042][bookmark: _Toc169270801]Adding a Language Profile
To add a Language Profile, select Add Language Profile, then press Enter or a cursor routing key.
You are prompted to enter the following options:
· Profile name: Type the name for the profile in the brackets, then press Enter.
· Braille grade: Choose between Uncontracted, Contracted, and Computer braille, then press Enter. Note that the Brailliant allows you to hide contracted braille and/or computer braille when toggling between the Braille grades.  
· Computer braille table: Select your computer braille table, then press Enter. Select none to avoid Computer braille toggle.
· Uncontracted braille table: Select your uncontracted braille table, then press Enter.
· Contracted braille table: Select your contracted braille table, then press Enter. Select none to avoid Contracted braille toggle.
· Content Voice: Select the content voice of your choice, then press Enter. Select None to turn the Content voice off. Voices available depend on your selection for the System voice and additional voice, which can be changed from Voice selection within the Speech settings. 
· Save configuration: Press Enter to save your configuration. 
The new Language Profile is now available in the Language Profile Settings menu.
11.2.2. [bookmark: _Toc169270802]Configuring or Deleting a Language Profile
To configure or delete a Language Profile:
· In the Options menu, select the item Language Profile. 
· Scroll through the available Language Profiles using the Next and Previous thumb keys.
· Press Space + M to open the Context menu. 
· Select Configure Language Profile OR Delete Language Profile and press Enter.
· Alternatively, Configure profile and Delete profile can be selected in the Language Profile menu.
11.3. [bookmark: _Toc146725672][bookmark: _Toc169270803]Text-to-speech
The Brailliant allows for the text that appears on the braille display to be heard via a text-to-speech (TTS) feature, which will adapt to the system language chosen.
Note that by default, the device only supports TTS for English and Spanish languages. If you have English or Spanish selected as your system language, then TTS will be activated. If an alternative language is chosen, then you will be prompted to download that language upon having an active network connection.
Please note that the first time the Brailliant will be connected to a WiFi network after the update or a factory reset, and no matter if a voice is active by default or not, a dialog will prompt inviting you to download language and voices. 
To activate/deactivate the text-to-speech feature:
· In the Options menu, select the item Speech Settings and press Enter.
· Use the Previous and Next thumb keys until you reach Speech settings.
· Press Enter to toggle the Speech settings On or Off.
Alternatively, you can use the Space + Previous Thumb Key shortcut to toggle the Speech feature On or Off.
While editing text in KeyPad or reading a document in Victor Reader, you can press Space + G, which will start reading the text from the current position. Use the Backspace + Enter shortcut to stop reading.
Note: When using the KeyBrf application, TTS will not be available.
11.3.1. [bookmark: _Toc146725673][bookmark: _Toc169270804]Voice Selection
While navigating the device, you can select a menu voice that will be used to read menus, system messages and content. If you wish to use an alternative voice for your content reading, you can do so by selecting the change additional voice item. Your content voice can then later be changed within the language profiles. 
11.3.1.1 Change menu voice
· In the Options menu, select Speech Settings and press Enter.
· Use the Previous and Next thumb keys until you reach the download language and voices selection item and press Enter. A submenu will appear.
· Choose Change Menu Voice (current voice will be specified) and press Enter.
· Select the variant of your system language (for example, English North America) that you want if more than one is available.
· A list of available voices will appear. Choose a voice from the list and press Enter.
Any changes to the voices will require a restart of the device.
11.3.1.2 Change an additional voice
· In the Options menu, select the item Speech Settings and press Enter.
· Use the Previous and Next thumb keys until you reach the download language and voices selection item and press Enter. A submenu will appear.
· Choose Change Additional Voice (current voice will be specified) and press enter.
· Select the desired language, then the language variant (for example, French Canada) that you want, if more than one is available.
· A list of available voices will appear. Choose a voice from the list and press enter.
Any changes to the voices will require a restart of the device.

For information about selecting a Content voice, which will read content in KeyPad and Victor Reader, please see the section Adding, Configuring, and Deleting Language Profiles.
11.3.1.3 Swap voices
This option permits you to swap between the two voices installed on your device. To do so:
· In the Options menu, select the item Speech Settings and press Enter.
· Use the Previous and Next thumb keys until you reach the “download language and voices” selection item and press Enter. A submenu will appear.
· Choose the option “Swap voices”, then press Enter.
Any changes to the voices will require a restart of the device.
11.3.2. [bookmark: _Toc146725674][bookmark: _Toc169270805]Speech Settings Table
Table 9: Speech Settings Options 
	Setting
	Option/Result

	Speech
	On or off; when off, all speech features are disabled.

	Speak menu
	On or off; when off, all speech features are disabled while navigating in the menus but stay enabled in the applications.

	Speak word under cursor
	On or off; when on, the user can press on a cursor routing key and the word below the key will be read.

	Speak display content after panning
	On or off; when on, the speech feature will read the remainder of a line when the user pans it on the braille display.

	Echo delete
	On or off; when on, the device will speak the characters deleted with the Backspace key.

	Keyboard echo
	Words, Characters, Characters and Words or Off; the item chosen determines what will be spoken when typing on the keyboard.

	Download language and voices
	Change menu voice, change additional voice, swap voices



11.4. [bookmark: _Refd18e3068][bookmark: _Tocd18e3068][bookmark: _Toc169270806]Using a Wi-Fi Network or Bluetooth
11.4.1. [bookmark: _Toc146119706][bookmark: _Toc146119992][bookmark: _Toc146120150][bookmark: _Toc146180059][bookmark: _Toc146180380][bookmark: _Toc146181356][bookmark: _Toc146181513][bookmark: _Toc146181733][bookmark: _Connecting_to_a][bookmark: _Toc169270807]Connecting to a Wi-Fi Network
Select New Connection from the Wi-Fi menu, then press Enter or a cursor routing key to access it. You can also use the global shortcut to access the wifi search (note that if airplane mode is enabled, it will disallow access).
There are three connection choices:
· Scan for SSID: Select this option to discover the available networks in your vicinity. When Brailliant is done scanning, it displays a list of all the networks it found. 
· Select one of them,  then
· Press Enter or a cursor routing key to select this network. Then enter the password, and press Enter to complete the connection.
· WPS Connection: Select this option to establish a Wi-Fi Connection using WPS. The Brailliant displays “loading...” for approximately 30 seconds. Press the WPS button on your network Router to turn on discovery of new devices. After a few seconds, you are automatically connected to the network.
· Manually Connect: To enter the SSID of your network and the password manually, select this option. When done, press Enter to connect.
11.4.2. [bookmark: _Refd18e3080][bookmark: _Tocd18e3080][bookmark: _Toc169270808]Wi-Fi Settings Table
The available Wi-Fi Settings are listed in Table 10.
Table 10: Wi-Fi Settings
	Setting
	Option/Result

	Wi-Fi
	Press Enter to turn Wi-Fi On or Off

	Status
	Provides information about your current Wi-Fi status

	New connection
	Press Enter to create a new Wi-Fi connection

	Launch connection
	Connect to a Wi-Fi network known by your device

	Delete connection 
	Make your device forget a known Wi-Fi network

	Network settings
	Change advanced network settings, such as Mode, IP, Subnet mask, Gateway, and DNS

	Import Wi-Fi
	Import Wi-Fi network information from a file


11.5. [bookmark: _Refd18e3137][bookmark: _Tocd18e3137][bookmark: _Toc169270809]Choosing Bluetooth Mode Options
The following Bluetooth mode options are available on the Brailliant BI 20X.
· Bluetooth mode: On or Off
· Connect device: Connect the Brailliant with a paired Bluetooth device
· Disconnect device: Disconnect the active Bluetooth connection
· Delete paired device: Makes your device forget a Bluetooth device
12. [bookmark: _Customize_KeySofts_Main][bookmark: _Toc169270810]Customize KeySoft’s Main Menu
The Customization function allows you to take items off the Main menu of the Brailliant. This feature is useful for beginners who wish to simplify the usage of their device.
To customize the main menu applications:
· Go to the Main menu.
· Select Options.
· Press Enter. 
· Go to Main menu applications.
· Press Enter.
· A list of the Main menu applications will appear. Go to the application you wish to take off the menu, and press on Enter to toggle it to Off. Pressing Enter again will toggle it back to On.
· Press on Save to apply the changes.  
13. [bookmark: _Toc82445390][bookmark: _Toc169270811]One-Handed Mode
The Brailliant can be used in a one-handed mode that allows entering shortcuts with only one hand. When the one-handed mode is activated, the way that Braille input and commands are performed changes. Each key can be pressed and released one by one, and the dot combination is only confirmed once the space key is pressed. To insert a blank space between words, press the space bar twice. 
To perform braille commands, the same logic is used for the input of characters. For Braille commands that involve the space bar, such as the Go to top (Space with dots 1,2,3) command, an additional space bar press is required. 
For example, to perform the Go to top command (standard command is space with dots 1,2,3): press space, then dot 1, then dot 2, then dot 3, then space. 
Note: the operation of the thumb keys and cursor routing keys remains the same as with the standard two-handed mode.
To activate/deactivate the one-handed mode:
· Go to the Main menu.
· Select Options and press Enter. 
· Select User Settings and press Enter.
· Use the Previous and Next thumb keys until you reach the One-handed mode item.
· Press Enter to activate the One-handed mode; press Enter again to deactivate it.
14. [bookmark: _Toc169270812]Change Language
To change the system language of the Brailliant BI 20X:
· Go to the Main menu.
· Select Options.
· Select Change Language.
· Select the Language option and press Enter. A list will appear on the display. 
· Select the language of your choice from the list. 
· Select Close.
· You will be prompted to select the option Replace Language default profile. If you click on Ok, a new Language Profile will be created with a Braille table allowing to read Braille menus in the selected language. Press Cancel if you wish to stay with your current Language Profile.
· When prompted, reboot the Brailliant to apply the changes. 
15. [bookmark: _Toc169270813]Accessing and Using Online Services
[bookmark: _Hlk37938939]This Online Services menu contains online libraries included on your Brailliant. The Online Services are subscription-based and require you to enter your account credentials.
Note: Make sure you have an established internet connection with the Brailliant before using Online Services. 
Books from online libraries are downloaded in the Online-books folder of the Brailliant. All books are included in the Main Book list of the Victor Reader application.
15.1. [bookmark: _Toc169270814]Activating Bookshare and Downloading Books
[bookmark: _Hlk37939116][bookmark: _Refd18e3170]Bookshare® online library contains copyrighted content for people with qualifying print disabilities. More information about Bookshare is available from http://www.bookshare.org. 
You are able to search for books and download them to the Brailliant wirelessly. Newspapers and magazines are currently not available in the online search.
To activate the Bookshare service and download a book: 
· Enter your Bookshare account email address and password. 
· Select your preferred book format (DAISY or BRF).
· Search books by title, author, full text search, and/or browse by categories. You can also search for the most recent or popular books.
· Press Enter or a cursor routing key on a book to get more information. 
· Use Previous and Next thumb keys to navigate between the title, author, and book description. 
· Press Enter on the Download item to download the book to the Brailliant. 
15.2. [bookmark: _Toc169270815]Configuring, Managing, and Syncing an NFB Newsline Account
[bookmark: _Hlk37939337]If you have an NFB Newsline® account, the Brailliant allows you to connect to your account and download NFB material for reading in the Victor Reader.
Configure account: Enter your NFB Newsline credentials, select the issue update frequency, and determine whether your Brailliant should keep or delete outdated issues.
Manage publications: Select which material you wish to subscribe to. Subscribed material is underlined.
Sync content now: Downloads the latest issues of your subscribed material.
15.3. [bookmark: _Toc169270816]NLS Bard
The Brailliant can access BARD directly. You can view and download books from the most popular books list and the most recent books and magazines list. You can browse subject categories and search the collection. You can also download books and magazines from your wish list as well as add and remove items from it. Before you can access BARD, you must connect your device to a Wi-Fi network (see Connecting to a Wi-Fi Network for detailed instructions) and login to your BARD account.
[bookmark: _Toc146725685][bookmark: _Toc169270817]15.4. DAISY Online
DAISY online is a service that supports several libraries of adapted content across the world.
To access the DAISY Online libraries supported by the device, follow these steps: 
Note: to access DAISY online libraries, an Internet connection is required. 
· On the main menu, with the Previous and Next thumb keys, navigate until reaching the item “Online Services” and press Enter.
· Using the Previous and Next thumb keys, navigate to the DAISY online item, then press Enter.
You will now have a list of any of the DAISY Online accounts that you have previously configured, followed by the “Add account” item. If you did not configure any DAISY Online account, the “Add account” item will be the first one displayed when opening the DAISY Online application. You will have to add an account to see the list of available libraries. To do so, follow instructions below.
15.3.1. [bookmark: _Toc146725686][bookmark: _Toc169270818]Adding a DAISY Online account 
· From the main menu, with the Previous and Next thumb keys, navigate until reaching the item “Online Services” and press Enter.
· With the Previous and Next thumb keys, navigate until reaching the item “DAISY Online”, then press Enter. 
· With the Previous and Next thumb keys, navigate until reaching the item “Add account”, then press Enter.
· The list of available libraries will be displayed. Select the one in which you have an account that you want to configure, then press Enter on this library.
· Enter the username for this account, then press Enter.
· Enter the password for this account, then press Enter.
If the connection is established, you will get the message “login successful” and a new account will be added to the list of already configured libraries that you will see when opening the DAISY Online app.
Note: when your cursor is on an already configured account, you can press the shortcut Space+M to go to the contextual menu. You will have the option to change the download method (automatic or manual), to modify login information, or to remove this specific account.
15.3.2. [bookmark: _Toc146725687][bookmark: _Toc169270819]Import Configuration
In conjunction with the HumanWare Companion application, the Brailliant allows importing a library configuration from a XML file. This process requires both an active network connection and an XML file located on an external drive. To download the HumanWare companion, please visit https://support.humanware.com/en-international/support/humanware_companion

To import a configuration, do the following:
· In the main menu, using the Previous and Next thumb keys, navigate until reaching the item “Online services”, then press Enter.
· With the Previous and Next thumb keys, navigate until reaching the item “DAISY Online”, then press Enter.
· On the displayed menu, navigate with the Previous and Next thumb keys until reaching the item “Import configuration”, then press Enter. A message indicating the result of the import will be displayed. If the import is a success, one or more new configured account will be added to your device, depending of the information from the XML file.
15.3.3. [bookmark: _Toc146725688][bookmark: _Toc169270820]Downloading a book from a DAISY Online library configurd on your device
15.4.3.1 Automatic download
By default, when adding a new account, the option “automatic download” is selected, meaning that the books present in the bookcase of this account will be automatically downloaded when the Brailliant will be connected to a WiFi network. To access to the downloaded books, do the following:
· On the main menu, navigate with the Previous and Next thumb keys until reaching the item “Online services”, then press Enter.
· With the Previous and Next thumb keys, navigate until reaching the item “DAISY Online”, then press Enter.
· With the Previous and Next thumb keys, navigate until reaching the account previously configured, then press Enter.
· You can see the books, in this bookcase, that have been downloaded. The title of the book is displayed, followed by the mention “downloaded”. At that time, no action is required, as your books will continue to download automatically until the last one in the bookcase or until the memory of your Brailliant will be full.
· At any time, you can force the synchronization of your content. At the end of the book list, the option “Sync content now” is present. Press Enter on this option and the device will search for any new content in your account. A message indicating that no new content has been found or indicating the number of new elements found, if any, will be displayed, and the synchronization of these new elements will begin automatically.
15.4.3.2 Manual download
When configuring a new DAISY Online account, the option “automatic download” is configured by default. However, it is possible to change the download method if you prefer to download your books manually. To do so, do the following:
· On the main menu, navigate with the Previous and Next thumb keys until reaching the item “Online services”, then press Enter.
· With the Previous and Next thumb keys, navigate until reaching the item “DAISY Online”, then press Enter.
· With the Previous and Next thumb keys, navigate until reaching the account configured that interests you. 
· Press Space+M to go to the contextual menu.
· With the Previous and Next thumb keys, navigate until reaching the item “Download method”, followed by the value of this element. Press Enter on this item.
· You will now have the choice between “automatic download” and “manual download”. With the Previous and Next thumb keys, navigate until reaching the option “Manual download”, then select it by pressing Enter.
With the manual download method, you will have to select manually the books that you want to download. To do so, do the following:
· On the main menu, use the Previous and Next thumb keys to go to the option “Online services”, then press Enter.
· In the displayed list, with the Previous and Next thumb keys, go to DAISY Online, then press Enter.
· A list of configured libraries on your device will be displayed. With the Previous and Next thumb keys, navigate until reaching the library that you have previously configured with the manual download method, then press Enter.
· You will see the list of already downloaded books, if any, and a “Download more books” option will be displayed at the end of the list. With the Previous and Next thumb keys, navigate until reaching the “Download more books” option, then press Enter.
· You will now have access to the books included in your bookcase for this account. With the Previous and Next thumb keys, go through the list and select the book that you want to download, then press Enter.
· With the Previous and Next thumb keys, navigate until reaching the option “Download”, then press Enter. The book will be placed in the download queue.
15.3.4. [bookmark: _Toc146725689][bookmark: _Toc169270821]Reading a Book you have downloaded
After you have downloaded a book or magazine, you can download additional items, or you can read one of them. To read an item:
· Return to the Main Menu by pressing the Home button. 
· Navigate to Victor Reader and press Enter. 
· Press Enter on Book List. Here, you will find your downloaded items. 
· Press Enter on the title you wish to read and you will be at the beginning of the book.
Alternatively, when on the book list of a specific account in the DAISY Online app, you can press Enter on a book, that will display the available options, then select the “Open book” option and press Enter. The book will open in Victor Reader and the reading will begin, starting from the beginning of the book.
15.4. [bookmark: _Toc1455342825][bookmark: _Toc169270822]Eole
Eole is a French library that contains accessible books for disabled people. You can access that resource by using the following URL: https://eole.avh.asso.fr/ 
More information about EOLE library can be found in the French user guide of this device alternatively it can be downloaded from on our website.

16. [bookmark: _Toc146180071][bookmark: _Toc146180392][bookmark: _Toc146180072][bookmark: _Toc146180393][bookmark: _Toc146180073][bookmark: _Toc146180394][bookmark: _Toc169270823]Exam Mode
[bookmark: _Hlk54687245]Exam Mode is used to block certain functions and applications from the Brailliant for a certain amount of time. While the Exam Mode is active, you will only have access to the Terminal functions. Note that Exam Mode, the Bluetooth connection is deactivated and Terminal mode is only accessible via USB. All other applications and the use of an external memory (USB drive or SD card) are blocked while this mode is active.
When activating the Exam mode, you will be prompted to enter a time between 1 and 360 minutes (6 hours) and will be asked to enter a desired password to turn off the exam mode. 
To unlock the device, you will need to either wait for the selected time to run out or enter the selected password. 
Upon restarting the device, if the period selected is not completed yet, the device will automatically go back to Exam Mode.
To activate the Exam Mode:
· Go to the Main menu.
· Select Options.
· Press Enter. 
· Go to Activate Exam Mode.
· Press Enter.
· Enter the desired time (between 1 and 360 minutes).
· Enter the desired password to activate the Exam Mode.
· Press Enter.
17. [bookmark: _Toc169270824][bookmark: _Toc45673404][bookmark: _Toc487351481][bookmark: _Refd18e3210][bookmark: _Tocd18e3210]Accessing the diagnostic menu
The Diagnostic menu is a special menu used to test internal components and also to realize some key operations especially when troubleshooting issues that you could have while using the device. 
Here are the steps to access the Diagnostic menu:
· If your device is plugged to an energy source, please unplug it.
· If your device is running, press the Power button during two seconds. Your device will indicate “Shut down?”. With the Previous and Next thumb keys, navigate until reaching the OK button then press on any cursor-routing key to activate it. Your device will shut down.
· Press simultaneously the Power and the Volume up keys until your device indicates “Recovery mode”, then release the buttons. After few seconds, the device will shutdown again.
· Boot the device normally by pressing the Power button during 2 seconds. The device will start again, and you will be directed to the Diagnostic menu.
You might need to use the diagnostic menu for the following operations:
· Factory reset
· Clear user data
· Clear user configuration
· Activate or de-activate Terminal only 
· Export logs when troubleshooting issues
· Exporting and importing data and configurations (see section 17.1 “Exporting and importing data and configurations” to know more).
Press on any cursor-routing key on the desired option to select it. Then, navigate with the Previous and Next thumb keys to reach the Close button and press on any cursor-routing key to select it. Your device will shutdown. Alternatively, you can close the diagnostic menu with the shortcut Space+E. 
Please note: some of the options in this menu are irreversible: the factory reset, the clear user data and the clear user configuration. When done, it is impossible to recover the content deleted.
17.1. [bookmark: _Toc169270825]Exporting and importing user data and configurations
The Brailliant contains an export and import utility both for your data and configurations such as Wifi and library credentials. There are several reasons why you would import and export. 
· Transferring your data to another device. Very useful if you have a care plan 
· General backup.
These options can only be accessed using the diagnostic menu. There are two types of export/import options to be aware of: 
· Export/import Configurations: This option refers to wifi and online book credentials. It will not, however export any Bluetooth configuration. 
· Export/import user content: This option refers to user data. This includes newly created folders and files. It will also export any books downloaded from the current library providers. (This could be subject to change on new any future libraries added. You cannot export data and configurations for DAISY Online libraries. 
To export configuration or user content:
· Access the diagnostic menu.
· Now, make sure to insert a USB thumb drive or a SD card; this is where you will export the data to. 
· There are several items in the Diagnostic menu. Depending on what you wish to export, use your Next thumb key to move to the item called either “Export configuration or Export user content”. 
· Press Enter or any cursor-routing key on your selected item. 
· You will now be prompted “Please wait” followed by “Export to USB done” or”Export to SD done” shortly after. 
· When the operation is finished, please shutdown your device by navigating with the Previous and Next thumb keys until reaching the Close button then press Enter or any cursor-routing key on it, or you can close the diagnostic menu with the shortcut Space+E.
Note: The exported configuration cannot be opened on a computer. 

To import configuration or user content:
· To import user content or configurations, you will once again need to boot the Brailliant BI X in diagnostic menu.
· Insert the USB thumb drive or the SD card, which contains the file to import. 
· Using your Previous and Next thumb keys, move to the item called either “Import configuration or Import user content” then press Enter. 
· You will be prompted “Please wait” followed shortly by “Import done”. 
· After the completion of the operation, please close the device by navigating with the Previous and Next thumb keys until reaching the Close button then press on Enter or any cursor-routing key. Alternatively, you can also close the device with the shortcut Space+E.
Important Note: All recently created content or editing of existing content made after the export file was generated will be deleted.
18. [bookmark: _Toc169270826]Technical Specifications
18.1. [bookmark: _Toc169270827]Navigation components
· 4 Thumb keys
· 8-key Braille keyboard
· 2 Space bars
· Cursor routing keys
18.2. [bookmark: _Toc169270828]Long-life battery
· Lasts up to 20 hours
· Recharges from PC through USB port
· Auto shut-off
· Lithium-ion polymer battery
· Compatible with any standard USB A/C adapter
18.3. [bookmark: _Toc169270829]Connectivity
· USB 2.0
· SD card
· Wi-Fi 2.4 GHz
· Bluetooth V4.2
18.4. [bookmark: _Toc169270830]Portability
Dimensions : 93 mm x 182 mm x 23 mm
Weight: 400g 
19. [bookmark: _Toc169270831]Updating the Brailliant BI 20X
19.1. [bookmark: _Toc66876916][bookmark: _Toc169270832]Updating the Brailliant BI 20X manually
When connected to the Internet with the Brailliant, you can manually check if an update is available. 
To check for an update manually:
1. Go to the Main menu.
2. Select Options.
3. Press Enter. 
4. Select Software update.
5. Press Enter.
6. Select Check for update.
7. Press Enter.
If prompted with a new update, select Download by pressing the Previous or Next thumb key to download the update now or Remind me later to update it later. You can continue to use the Brailliant while the update is downloading.
Note that the device must be plugged in and the battery must be more than 50% charged for the update to be performed.
After a few minutes, Brailliant asks you to install the downloaded update. Select Ok to install it. The Brailliant reboots and a progress indicator line is shown on the braille display. 
At the end of the update process, all 8 dots of the 20 braille cells raise one column at a time and then the device shuts down.
19.2. [bookmark: _Toc66876917][bookmark: _Toc169270833]Updating the Brailliant BI 20X via USB or a SD card
You can update the Brailliant by downloading the update file on a computer and transferring it on a USB flash drive or a SD card. To update the Brailliant via USB or an SD card:
1. Insert a USB flash drive or SD card into your computer. 
2. Transfer the update file to the USB flash drive or SD card. Note that the update file needs to be placed at the root of the USB drive or SD card.
3. Insert the USB flash drive or SD card containing the update file into your Brailliant. Make sure your Brailliant is powered on.
4. When the Brailliant detects an update file on the USB drive or SD card, the braille display will prompt that an update is available for installation. 
5. Press the Next thumb key to reach the Ok item, and press Enter to activate the update prompted. The device will shut down and restart to process the update.
The latest update is always available on the Brailliant BI 20X product page.
19.3. [bookmark: _Toc66876918][bookmark: _Toc169270834]Automatic Check for Update Feature
By default, an Automatic check for update feature is enabled. When connected to the internet, the Brailliant regularly looks if a new update is available for download. If an update is available, the Brailliant will prompt you to download it. 
To disable/enable the Automatic check for update feature, follow these steps:
1. Go to the Main menu.
2. Select Options.
3. Press Enter.
4. Go to Software Update.
5. Press Enter.
6. Select Automatic check for updates.
7. Press Enter to enable/disable the feature.
Note that when enabled, the Brailliant will check every 23 hours if a new update is available.
20. [bookmark: _Toc67304798][bookmark: _Toc67304799][bookmark: _Toc67304800][bookmark: _Toc67304801][bookmark: _Toc67304802][bookmark: _Toc67304803][bookmark: _Toc67304804][bookmark: _Toc67304805][bookmark: _Toc67304806][bookmark: _Toc67304807][bookmark: _Toc67304808][bookmark: _Refd18e3230][bookmark: _Tocd18e3230][bookmark: _Toc169270835]Customer Support
[bookmark: humanware]For customer support, please contact the HumanWare office nearest you or visit our Website at: www.humanware.com/support
Global: support@humanware.com
North America: 1 800 722-3393
us.support@humanware.com
Europe: (0044) 1933 415 800
eu.support@humanware.com
Australia / Asia: (02) 9686 2600
au.sales@humanware.com
21. [bookmark: _Toc169270836][bookmark: _Toc477772532][bookmark: _Toc403987875]Proper Trademark Notice and Attributions 
macOS is a registered trademark of Apple Inc. 
JAWS is a registered trademark of Freedom Scientific, Inc. in the United States and other countries.
Bookshare® is a registered trademarks of Beneficent Technology, Inc. 
NFB Newsline is a registered trademark of the National Federation of the Blind
Bluetooth is a registered trademark of Bluetooth SIG, Inc. 
IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license. 
All other trademarks are the property of their respective owners. 
22. [bookmark: _Toc169270837]End User License Agreement
By using this Product (Brailliant BI 20X), you agree to the following minimum terms:
0. License Grant. HumanWare grants to End User a non-exclusive, non-transferable right and licence to use the Software on this product.
0. Ownership of Software. End User acknowledges that HumanWare retain all right, title and interest in and to the original, and any copies, of software which is incorporated into this product. End User agrees not to: modify, port, translate, decompile, disassemble, reverse engineer, or make public in any way the software of this Product.
23. [bookmark: _Refd18e3590][bookmark: _Tocd18e3590][bookmark: _Toc169270838]Warranty
Manufacturer Warranty
This device is a high-quality product, built and packaged with care. All units and components are guaranteed against any operational defects for 2 years for all countries.
Warranty covers all parts (except battery) and labor. If any defect should occur, please contact your local distributor or the manufacturer technical assistance line.
Note: Warranty terms may periodically change, please consult our website for the latest information.
Conditions and Limitations:
Please keep your bill of purchase in a safe place as it may be required for a warranty repair or replacement. Please retain your original. If the unit has to be returned, please use the original packaging. This warranty applies to all cases where the damage is not a result of improper use, mistreatment, negligence or acts of God.
North America:  In addition to the warranty, you can also purchase a Service Contract to prolong coverage for one year and also benefit from the cleaning service. Please refer to our web site: http://www.humanware.com/  
Or contact us by E-mail at us.info@humanware.com  or call 1(800) 722-3393


[bookmark: _Toc66876924][bookmark: _Toc169270839]Appendix A – Command Summary
Note: All commands that include Enter or Backspace must have the Space Bar added to them when using computer braille.
Shortcut/Key Combination Table
	Action
	Shortcut or Key Combination

	Activate Selected item
	Enter or cursor routing key

	Escape or Back
	Space + E

	Previous item
	Previous thumb key or Space + Dot 1

	Next item
	Next thumb key or Space + Dot 4

	Jump to any item in a list
	Type the first letter of the item or app

	Pan left and right
	Left or Right thumb key

	Go to top
	Space + Dots 1-2-3

	Go to bottom
	Space + Dots 4-5-6

	Toggle Braille grade
	Backspace + G

	Switch language profile
	Enter + L

	Battery level
	Enter + P

	Context menu
	Space + M

	Main menu
	Space + Dots 1-2-3-4-5-6 or Home button

	System information
	Space + I

	Time
	Enter + T

	Date
	Enter + D

	Eject media
	Enter + E

	Options
	Space + O

	Create a quick note
	Backspace + N

	Create a quick braille note
	Backspace + B

	Toggle speech on/off
	Space + Previous Thumb Key

	Increase speech rate
	Enter + Dot 5

	Decrease speech rate
	Enter + Dot 2

	Open Terminal
	Backspace + Enter + T

	Open KeyPad
	Backspace + Enter + E

	Open Victor Reader
	Backspace + Enter + V

	Open KeyFiles 
	Backspace + Enter + F

	Open KeyCalc
	Backspace + Enter + C

	Open Bookshare
	Backspace + Enter + B

	Open NFB Newsline
	Backspace + Enter + W

	Open NLS Bard
	Backspace + Enter + N

	Search for WiFi
	Backspace + Enter + S

	Help
	Space + H



KeyPad Commands
	Action
	Shortcut or Key Combination

	Activate edit mode
	Enter or a cursor routing key

	Leave edit mode
	Space + E

	Create file
	Backspace + N

	Open file
	Backspace + O

	Save
	Space + S

	Save as
	Backspace + S

	Find 
	Space + F

	Find next
	Space + N

	Find previous
	Space + P

	Replace
	Backspace + F

	Start/Stop selection
	Enter + S

	Select all 
	Enter + Dots 1-2-3-4-5-6

	Copy
	Backspace + Y

	Cut
	Backspace + X

	Paste
	Backspace + V

	Delete previous word
	Backspace + Dot 2

	Delete current word
	Backspace + Dots 2-5

	Delete previous character
	Backspace 

	Move to next edit box while editing
	Enter 

	Move to next edit box without editing
	Next thumb key

	Move to previous edit box without editing
	Previous thumb key

	Move insertion point to start of text field document
	Space + Dots 1-2-3 

	Move insertion point to end of text field document
	Space + Dots 4-5-6 

	Start auto-scroll
	Enter + Dots 1-2-4-5-6

	Increase auto-scroll speed
	Enter + Dot 6

	Decrease auto-scroll speed
	Enter + Dot 3

	Read all (text-to-speech feature)
	Space + G

	Stop the text-to-speech
	Backspace + Enter

	Toggle Reading mode 
	Space + X

	Bookmark menu
	Enter + M

	Jump to bookmark
	Enter + J

	Insert Quick Bookmark
	Enter + B



KeyBrf Commands
	Action
	Shortcut or Key Combination

	Activate Edit mode
	Enter or a cursor-routing key

	Leave Edit mode
	Space + E

	Create file
	Backspace + N

	Open file
	Backspace + O

	Save
	Space + S

	Save as
	Backspace + S

	Find 
	Space + F

	Find next
	Space + N

	Find previous
	Space + P

	Replace
	Backspace + F

	Start/stop selection
	Enter + S

	Select all 
	Enter + A

	Copy
	Backspace + Y

	Cut
	Backspace + X

	Paste
	Backspace + V

	Delete previous word
	Backspace + Dot 2

	Delete current word
	Backspace + Dots 2-5

	Delete previous character
	Backspace 

	Move to next edit box while editing
	Enter 

	Move to next edit box without editing
	Next thumb key

	Move to previous edit box without editing
	Previous thumb key

	Move insertion point to start of text field document
	Space + Dots 1-2-3 

	Move insertion point to end of text field document
	Space + Dots 4-5-6 

	Start auto-scroll
	Space + Dots 1-2-4-5-6

	Increase Auto-Scroll speed
	Enter + Dot 6

	Decrease auto-scroll speed
	Enter + Dot 3

	Toggle Reading mode 
	Space + X

	Where Am I? (Format BRF option  On)
	Space + Dots 1-5-6

	Preview mode (Format BRF option  On)
	Enter + V

	Bookmark menu
	Enter + M

	Jump to bookmark
	Enter + J

	Insert Bookmark
	Enter + B


Victor Reader/Reading Commands for text books
	Action
	Shortcut or Key Combination

	Book list 
	Space + B

	Manage books
	Backspace + M

	Go to Option menu
	Enter + G

	Bookmark menu
	Enter + M

	Jump to bookmark
	Enter + J

	Insert Quick Bookmark
	Enter + B

	Show Highlight Bookmarks
	Enter + H

	Open Navigation level
	Space + T

	Previous Navigation level
	Backspace + Dot 3

	Next Navigation level
	Backspace + Dot 6

	Previous element
	Previous thumb key

	Next element
	Next thumb key

	Start Auto-scroll
	Enter + Dots 1-2-4-5-6

	Increase Auto-scroll speed
	Enter + Dot 6

	Decrease Auto-scroll speed
	Enter + Dot 3

	Read all (text-to-speech feature)
	Space + G

	Stop reading (text-to-speech feature)
	Backspace + Enter

	Where am I
	Space + Dots 1-5-6

	Info
	Space + I

	Go to beginning of book
	Space + Dots 1-2-3

	Go to end of book
	Space + Dots 4-5-6

	Open recent books 
	Enter + R

	Search for books or text
	Space + F

	Find next
	Space + N

	Find previous
	Space + P

	Next non-blank line
	Enter + Dot 4

	Previous non-blank line
	Enter + Dot 1

	Previous character
	Space + Dot 3

	Next character
	Space + Dot 6 

	Previous word
	Space + Dot 2

	Next word
	Space + Dot 5

	Previous paragraph
	Space + Dots 2-3

	Next paragraph
	Space + Dots 5-6

	Start/Stop selection
	Enter + S

	Select all (current paragraph)
	Enter + Dots 1-2-3-4-5-6

	Copy (current paragraph)
	Backspace + Y

	Delete book
	Backspace  + Dots 2-3-5-6



Victor Reader Commands for audiobooks
	Action
	Shortcut or Key Combination

	Book list 
	Space + B

	Manage books
	Backspace + M

	Go to Option menu
	Enter + G

	Bookmark menu
	Enter + M

	Jump to bookmark
	Enter + J

	Insert Quick Bookmark
	Enter + B

	Show Highlight Bookmarks
	Enter + H

	Open Navigation Level
	Space + T

	Previous element
	Previous thumb key

	Next element
	Next thumb key

	Change to previous Navigation level
	Backspace + Dot 3

	Change to next Navigation level
	Backspace + Dot 6

	Where Am I
	Space + Dots 1-5-6

	Info
	Space + I

	Go to beginning of book
	Space + Dots 1-2-3

	Go to end of book
	Space + Dots 4-5-6

	Open recent books 
	Enter + R

	Delete book
	Backspace + Dots 2-3-5-6

	Play audiobook
	Space + G

	Stop the reading
	Backspace + Enter

	Fast forward 5 seconds
	Right thumb key (single press)

	Rewind 5 seconds 
	Left thumb Key (single press)

	Fast forward (Longer time jumps)
	Right thumb key (press and hold)

	Rewind (Longer time jumps)
	Left thumb key (press and hold)

	Increase reading speed
	Enter + Dot 5

	Decrease reading speed
	Enter + Dot 2



KeyFiles Commands
	Action
	Shortcut or Key Combination

	Create new folder 
	Space + N

	File/drive info 
	Space + I

	Mark/Unmark
	Backspace + L

	Mark all/Unmark all 
	Enter + Dots 1-2-3-4-5-6

	Rename file
	Backspace + R

	Delete file
	Backspace + Dots 2-3-5-6

	Copy file 
	Backspace + Y

	Cut file
	Backspace + X

	Paste file
	Backspace + V

	Search file 
	Space + F

	Sort files 
	Space + V

	Where am I 
	Space + Dots 1-5-6

	Select drive 
	Space + D

	Go to parent folder
	Space + E

	Eject media
	Enter + E



Calculator Commands using US Computer Braille
	Action
	Shortcut or Key Combination

	Plus 
	Dots 3-4-6

	Minus
	Dots 3-6

	Multiply
	Dots 1-6

	Divide
	Dots 3-4

	Equals
	Enter

	Clear 
	Space + Dots 3-5-6

	Decimal point
	Dots 4-6

	Percent
	Dots 1-4-6

	Square root 
	Space + Dots 3-4-5

	Pi
	Space + Y





[bookmark: _Toc16495120][bookmark: _Toc66876925][bookmark: _Toc169270840]Appendix B – Braille Tables
[bookmark: _Toc500162118][bookmark: _Toc16495121][bookmark: _Toc66876926][bookmark: _Toc169270841]United States 8 dot Computer Braille
exclamation mark: '!' 2,3,4,6
quote: '"' 5
pound: '#' 3,4,5,6
dollar sign: '$' 1,2,4,6
percent: '%' 1,4,6
ampersand: '&' 1,2,3,4,6
apostrophe: ''' 3
left paren: '(' 1,2,3,5,6
right paren: ')' 2,3,4,5,6
asterisk: '*' 1,6
plus sign: '+' 3,4,6
comma: ',' 6
dash: ' ' 3,6
period: '.' 4,6
forward slash: '/' 3,4
colon: ':' 1,5,6
semi colon: ';' 5,6
less than: '<' 1,2,6
equals: '=' 1,2,3,4,5,6
greater than: '>' 3,4,5
question mark: '?' 1,4,5,6
at symbol: '@' 4,7
left square bracket: '[' 2,4,6,7
back slash: '\' 1,2,5,6,7
right square bracket: ']' 1,2,4,5,6,7
carat sign: '^' 4,5,7
underscore: '_' 4,5,6
grave accent: '`' 4
left curly bracket: '{' 2,4,6
vertical bar: '|' 1,2,5,6
right curly bracket: '}' 1,2,4,5,6
tilde: '~' 4,5
'0': 3,5,6
'1': 2
'2': 2,3
'3': 2,5
'4': 2,5,6
'5': 2,6
'6': 2,3,5
'7': 2,3,5,6
'8': 2,3,6
'9': 3,5
Uppercase letters:
'A': 1,7
'B': 1,2,7
'C': 1,4,7
'D': 1,4,5,7
'E': 1,5,7
'F': 1,2,4,7
'G': 1,2,4,5,7
'H': 1,2,5,7
'I': 2,4,7
'J': 2,4,5,7
'K': 1,3,7
'L': 1,2,3,7
'M': 1,3,4,7
'N': 1,3,4,5,7
'O': 1,3,5,7
'P': 1,2,3,4,7
'Q': 1,2,3,4,5,7
'R': 1,2,3,5,7
'S': 2,3,4,7
'T': 2,3,4,5,7
'U': 1,3,6,7
'V': 1,2,3,6,7
'W': 2,4,5,6,7
'X': 1,3,4,6,7
'Y': 1,3,4,5,6,7
'Z': 1,3,5,6,7
Lowercase letters:
'a': 1
'b': 1,2
'c': 1,4
'd': 1,4,5
'e': 1,5
'f': 1,2,4
'g': 1,2,4,5
'h': 1,2,5
'i': 2,4
'j': 2,4,5
'k': 1,3
'l': 1,2,3
'm': 1,3,4
'n': 1,3,4,5
'o': 1,3,5
'p': 1,2,3,4
'q': 1,2,3,4,5
'r': 1,2,3,5
's': 2,3,4
't': 2,3,4,5
'u': 1,3,6
'v': 1,2,3,6
'w': 2,4,5,6
'x': 1,3,4,6
'y': 1,3,4,5,6
'z': 1,3,5,6

[bookmark: _Toc16495122][bookmark: _Toc66876927][bookmark: _Toc169270842]United Kingdom 8 dot Computer Braille
exclamation mark: '!': 2,3,4,6
quote: '"' 4
pound: '#' 5,6
dollar sign: '$' 4,5,6
percent: '%' 4,6
ampersand: '&' 1,2,3,4,6
apostrophe: ''' 3
left paren: '(' 4,5
right paren: ')' 3,4,5
asterisk: '*' 3,5
plus sign: '+' 2,3,5
comma: ',' 2
dash: ' ' 3,6
period: '.' 2,5,6
forward slash: '/' 3,4
colon: ':' 2,5
semi colon: ';' 2,3
less than: '<' 2,3,6
equals: '=' 2,3,5,6
greater than: '>' 3,5,6
question mark: '?' 2,6
at symbol: '@' 2,3,4,6,7
left square bracket: '[' 1,2,3,5,6,7
back slash: '\' 5,7
right square bracket: ']' 2,3,4,5,6,7
carat sign: '^' 6,7
underscore: '_' 3,4,6
grave accent: '`' 2,3,4,6
left curly bracket: '{' 1,2,3,5,6
vertical bar: '|' 5
right curly bracket: '}' 2,3,4,5,6
tilde: '~' 6
Pounds sterling: '£' 2,3,6,7,8
degree sign: '°' 1,3,4,6,8
'0': 1,2,3,4,5,6
'1': 1,6
'2': 1,2,6
'3': 1,4,6
'4': 1,4,5,6
'5': 1,5,6
'6': 1,2,4,6
'7': 1,2,4,5,6
'8': 1,2,5,6
'9': 2,4,6
Uppercase letters:
'A': 1,7
'B': 1,2,7
'C': 1,4,7
'D': 1,4,5,7
'E': 1,5,7
'F': 1,2,4,7
'G': 1,2,4,5,7
'H': 1,2,5,7
'I': 2,4,7
'J': 2,4,5,7
'K': 1,3,7
'L': 1,2,3,7
'M': 1,3,4,7
'N': 1,3,4,5,7
'O': 1,3,5,7
'P': 1,2,3,4,7
'Q': 1,2,3,4,5,7
'R': 1,2,3,5,7
'S': 2,3,4,7
'T': 2,3,4,5,7
'U': 1,3,6,7
'V': 1,2,3,6,7
'W': 2,4,5,6,7
'X': 1,3,4,6,7
'Y': 1,3,4,5,6,7
'Z': 1,3,5,6,7
Lowercase letters:
'a': 1
'b': 1,2
'c': 1,4
'd': 1,4,5
'e': 1,5
'f': 1,2,4
'g': 1,2,4,5
'h': 1,2,5
'i': 2,4
'j': 2,4,5
'k': 1,3
'l': 1,2,3
'm': 1,3,4
'n': 1,3,4,5
'o': 1,3,5
'p': 1,2,3,4
'q': 1,2,3,4,5
'r': 1,2,3,5
's': 2,3,4
't': 2,3,4,5
'u': 1,3,6
'v': 1,2,3,6
'w': 2,4,5,6
'x': 1,3,4,6
'y': 1,3,4,5,6
'z': 1,3,5,6
***
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